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This document was developed as part of the continuing effort to provide guidance within the Georgia 
Department of Transportation in fulfilling its mission to provide a safe, efficient, and sustainable 
transportation system through dedicated teamwork and responsible leadership supporting economic 
development, environmental sensitivity and improved quality of life. This document is not intended to 
establish policy within the Department, but to provide guidance in adhering to the policies of the 
Department.

Your comments, suggestions, and ideas for improvements are welcomed.

Please send comments to:

State Design Policy Engineer

Georgia Department of Transportation One Georgia Center

600 W. Peachtree Street, 26th Floor Atlanta, Georgia 30308

DISCLAIMER
The Georgia Department of Transportation maintains this printable document and is solely responsible 
for ensuring that it is equivalent to the approved Department guidelines.
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Preface
Design Processing consists of the generation of Design Data for Construction Plan and Right of Way Plan 
Deliverables and coordination/oversight of other Plan Deliverables. Designers utilize the OpenRoads Designer 
(ORD) platform for the generation of the Design database(s) used in the development of highway project plans. 
Previously, GDOT utilized InRoads v8i, which opened inside of MicroStation v8i.  ORD, however, is both the Design 
and CADD platform in a single software.

These Design Guidelines have been developed as part of the statewide GDOT implementation of ORD. The intent 
of this document is to provide guidelines and standards for generating Design Data in ORD. These guidelines must 
be followed in detail in order to conform to the current GDOT standards for producing the required design data for 
plan deliverables. Updates to this document will be made periodically when minor revisions, additional 
information, and/or enhancements are added.

If there is any approved deviation from the standard file and data naming/feature style conventions as 
prescribed by this document - a detailed description of the deviation(s) and approved reasons for the 
deviation(s) shall be documented and included with the project files in electronic format.
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Contact Information
To submit any comments or questions regarding the information contained in this document, please contact the 
Office of Design Policy & Support by email at the following address:

SolutionsCenter@dot.ga.gov

In the Email Subject Header, please reference the ORD Design Guidelines

mailto:SolutionsCenter@dot.ga.gov?subject=ORD%20Design%20Guidelines
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Overview
These Guidelines cover the GDOT standards for generating Design Data by utilizing the OpenRoads Designer 
software. The procedures below depict the Project Initialization Standards and Conventions to create an ORD 
Design Project to GDOT format and the processes to create/generate the files which are to be submitted as 
deliverables to the Construction and Right of Way Offices.

All users are strongly encouraged to subscribe to the ROADS Notifications, so they are informed of all updates 
to the GDOT ORD-CE Workspace.  To subscribe, visit the ROADS web page and click the Subscribe button.

Document Content

Below is a list of topics covered in this document:

• Project Initialization Standards
• Standard Conventions
• Horizontal Alignments
• Vertical Alignments
• Component and Template Creation
• Corridor Creation
• Cross Section Sheets/Annotation Generation
• Construction Limits
• Earthwork
• Required Right of Way
• Survey Enhancements
• ORD Style Sheets
• Additional File Deliverables
• Deliverables

http://www.dot.ga.gov/PS/DesignManuals
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 Project Initialization Standards
Project Initialization Standards have been established in order to promote consistency and assist in the 
organization of project data. These standard project schemes help to ensure uniformity for all users who may 
work on the project.

1.1 GDOT Standard Files

In order to conform to current policy for plan deliverables – GDOT provides the requisite files needed to 
standardize OpenRoads Designer to GDOT requirements. The first step in the development of an ORD Project is 
to ensure that these standard files are being utilized. Instructions for downloading/installing the executables are 
included on the GDOT web page (see the links below). These files are required for any Survey/Design Data 
Projects generated for GDOT.

• ORD Standard Files Location for Internal GDOT Users – all users shall work in ProjectWise 
in order to access the latest ORD Standard Files in the GDOT Workspace. Users will not have 
access to the GDOT Workspace outside of ProjectWise as they did in MicroStation 
v8i/InRoads. Users internal to GDOT will not need to download any files in order to have 
the latest GDOT Standard Files.

• ORD Standard Files Location for External Users – an ORD 
(GDOT_Org_Civil_Standards_CaddAll.exe) executable file is available for download, 
accessible from the GDOT web page. This executable contains all of the GDOT OpenRoads 
Designer standard files. This file can be downloaded by navigating to the OpenRoads 
Designer links from the following location:

http://www.dot.ga.gov/PS/DesignSoftware/OpenRoads

The GDOT_Org_Civil_Standards_CaddAll.exe file contains all the standard GDOT files which are required to 
generate projects to GDOT standards.  This file is only needed for the administration of the workspace; 
individual users do not need to download this file unless they are responsible for administering the workspace 
independently.  Consultants have 3 options to administer the GDOT workspace:

1. Set up an administrative workspace on a shared network drive and have individual users map to 
this network drive, similar to how it was done in MicroStation v8i.

2. Copy these files directly onto individual users’ machines, similar to how it was done in 
MicroStation v8i.

3. Administer the workspace in ProjectWise.

The Consultant workspace administrators may find instructions on how to install the GDOT ORD Workspace 
here: http://www.dot.ga.gov/PartnerSmart/DesignSoftware/OpenRoads/Install%20Instructions.pdf

http://www.dot.ga.gov/PS/DesignSoftware/OpenRoads
http://www.dot.ga.gov/PartnerSmart/DesignSoftware/OpenRoads/Install%20Instructions.pdf
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1.2 Standard Project Structure

Internal ORD users shall utilize ProjectWise to store all ORD Project Files.  DGN files for Design shall be saved in 
the DGN-CE folder.

1.3 Starting a Design Project in ORD

1.3.1 Copy and Rename the SDE DGN Files

The Designer will receive from the SDE (Survey Data Engineer) some or all of the following electronic files. These 
files will be copied in ProjectWise from the Location Database folder, over to the project folder Roadway 
Design\DGN-CE\ in ProjectWise for Internal GDOT Users.  Designers will not utilize any files directly residing in 
the Location Database folder.

• PI#TOPO.dgn (Existing Topo and Property features, plus Terrain Model)
• PI#UTLE.dgn  (Existing Utility features)
• PI#PSR.xls (Property Statistics Report)
• PI#Hydraulics.docx (Hydraulics report)
• PI#Misc.txt (Miscellaneous information SDE deems important. This file may not be included.)

1.3.2 Template Library

The Standard GDOT Template Library is GDOT_Standards_CE.itl. For internal GDOT users, this is what opens 
initially by default in ORD. Internal users should save and rename this file to GDOT_Design.itl in the ProjectWise 
project folder Roadway Design\DGN-CE\. Renaming in this manner will allow the GDOT_Design.itl file to 
become the default ITL file that opens for that specific project in ORD. It is recommended that external users 
follow this same file naming, even if not using a ProjectWise-managed workspace for ORD. As long as the ITL file 
is located in a project’s folder, there should be no confusion on which project the ITL is for. As an alternative 
naming solution, designers may also use PI#.itl as the file name, but doing so may require you to manually 
navigate and open the desired ITL for a project with each new session of ORD.

Any future updates made by the Engineering Software Standards Group to the GDOT_Standards_CE.itl will need 
to be manually updated on each individual project using the Template Library Organizer and then applied to 
each project template, as needed.  External users can obtain this file by downloading the 
GDOT_Org_Civil_Standards_CaddAll.exe file from the ROADS web page.

1.4 Starting OpenRoads Designer

Internal designers should have a Starting_Point.dgn file located in their Project’s DGN-CE folder on ProjectWise.  
To create a new working file, it is recommended to first open this Starting_Point.dgn file and then select 
File>New. Name the new file appropriately and perform the work only in this new file. No work should be done 
in the Starting_Point.dgn file. Using this workflow will automatically use the PW workspace and most recent 
GDOT_ORD_2D.dgn seed file.  External users will need to ensure they are selecting the GDOT_Standards 
Workspace, appropriate WorkSet, and GDOT_ORD_2D.dgn seed file.

Note: 3D seed files are only to be used for the creation of terrain or survey data (i.e. the delivered PI#TOPO.dgn 
file); 2D seed files should be what all designers are using for geometry, corridors, superelevation, etc.
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1.5 Overview of ORD Ribbon Interface

To become familiarized with the general OpenRoads Designer Ribbon Interface, all users should go through the 
QuickStart – Navigating the Interface training in the 00 – Roadway Design Modeling – Fundamentals Learning 
Plan: https://learning.bentley.com/learn/learning-plans/614/00-roadway-design-modeling-
fundamentals/courses/667/navigating-the-interface/lessons

GDOT has the following custom Workflows on the Ribbon Interface:

• GDOT Bridge

• GDOT Interface Tools 

• GDOT PDF Plotting

• GDOT Survey

https://learning.bentley.com/learn/learning-plans/614/00-roadway-design-modeling-fundamentals/courses/667/navigating-the-interface/lessons
https://learning.bentley.com/learn/learning-plans/614/00-roadway-design-modeling-fundamentals/courses/667/navigating-the-interface/lessons
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  Standard Conventions
This section provides an overview of the GDOT standard Project, File and Geometry Object naming conventions 
utilized for Design. A Design Feature Definitions Table is provided which lists the applicable Feature Definitions 
available for use in Design. The Photogrammetry/Survey Feature Code Tables are also provided as Reference 
Information so that the Designer can refer to these Feature Codes/Definitions when working with Existing 
Survey/Mapping Data.

2.1 Project and File Naming Conventions

As mentioned previously in Section One, in order to ensure Project and File Naming consistency and uniformity, 
standard Project and File Naming conventions have been established. The Designer must follow these naming 
procedures in order to conform to GDOT standards and policies.

This section details the following Standard Naming Conventions:

• Standard Project Naming Conventions
• Standard File Naming Conventions

2.1.1 Standard Project Naming Conventions

The standard ProjectWise File Structure for ORD is a Project Folder named DGN-CE residing within the main 
folder named for the PI Number of the project. All ORD DGN files placed in this folder will open automatically in 
ORD with the GDOT Workspace.  This is the folder location where the core Design File data is located. Other 
subfolders within the DGN-CE folder may be used to help further organize files, as needed. (See Table 2.1)

Table 2.1

Standard Project Naming Conventions

ProjectWise Project 
Structure

PI# - (description)\PE (Preconstruction)\Roadway Design\DGN-CE\

ProjectWise 
Project Structure 
(Example)

0013379 – Butts – Op Improvements – SR 36 Conn\PE (Preconstruction)\Roadway 
Design\DGN-CE\
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2.1.2 Standard File Naming Conventions

OpenRoads Designer, unlike InRoads, contains all information inside of the .DGN file itself.  It does, however, still 
utilize the .ITL (Template File) as InRoads did, as well as the associated .DGN file deliverables.  It is not 
recommended to bring forward InRoads .ITL files, as many point names have changed, Feature Definitions would 
need to be assigned, and many of the components have been further modified.  The following are the applicable 
file naming conventions (See Table 2.2)

Table 2.2
Standard File Naming Conventions

File Type File Name Example Name(s)

2D “Working”  DGN file
used as the standard DGN file for 
producing graphics and/or design 
data in ORD. Use this file to create 
all other Design DGN files (see 
Section 1.4 above)

starting_point.dgn 1234567GEOM-SR92.dgn

1234567CORD-SR92.dgn

1234567SUPR-SR92.dgn

ITL – Template Library File
A standard GDOT ITL File named 
GDOT_Standards_CE.itl is provided. 
The Designer will copy this file to the 
Project Directory and rename it to 
GDOT_Design.itl or PI#.itl [see Section 
1.3.2 for more details]

GDOT_Design.itl
PI#.itl

GDOT_Design.itl
1234567.itl
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2.2 Standard Geometry Object Names and Feature Definitions

The following section details the Standard Design and Survey Geometry Object Naming Conventions.

The SDE provides copies of the existing survey data in the PI#TOPO.DGN file, as well as the Utility data in the 
PI#UTLE.DGN file. This survey data consists of Property, Existing Right of Way, Alignments, Field Survey data, etc.  
The original files will be maintained by SLB. (See ORD SDE Guidelines for more detail).

The Designer will store all proposed Geometry Data (Geometry Points, Horizontal Alignments and Vertical 
Alignments) in a separate .DGN file.

NOTE: The term Horizontal Alignments represents not only Baseline Alignments but also Right of Way 
Alignments, Easement Alignments, Edge of Pavement Alignments, Ditch Alignments, etc.

NOTE: When generating a curve table for plan sheets, the Designer will manually name the Curve Table Curve 
Number. This is described in more detail in Section 3.5.

2.2.1 Standard Design and Survey Object Naming Conventions

ORD contains several different object types such as Points, Horizontal Alignments and Vertical Alignments. 
Following are the applicable object naming conventions (See Tables 2.3 – 2.5). The Designer shall follow the 
guidelines below when storing design geometry objects in ORD. These guidelines must be followed in order to 
conform to current GDOT standards and policies. Use only one prefix (DE) for Design points in ORD and begin 
point numbering at 1 (i.e. DE1).

A. Design Object Names

The Design Geometry Objects consist of Geometry Points, Horizontal Alignments and Vertical Alignments. The 
Designer will store Proposed Construction Baselines, Required R/W Alignments, Easement Alignments, Edge of 
Pavement Alignments, etc. The following Naming Conventions shall be used.

Object Type Example Name
*Design Geometry Points DE1

**Design Non-Baseline Horizontal Alignments DE1

**Design Baseline Horizontal Alignments Roadway Name

***Design Non-Baseline Vertical Alignments DE1

***Design Baseline Vertical Alignments Roadway Name 

• All Design Geometry Points must be named with a prefix of DE and be assigned a unique 
number, beginning with the number 1 (e.g., first design point = DE1, 2nd, DE2, etc.).  
*Geometry Points are only necessary for Horizontal Alignments used to create Right of 
Way and/or Easements.

• **All names must be unique.

• ***The Design Vertical Alignment (which corresponds with the Horizontal Alignment) 
shall be named the same as the associated Horizontal Alignment.  Only baseline 
alignments should be named after the Roadway Name.
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B. Survey Object Names and Point/Alignment Ranges:

The SDE stores any computed and/or existing survey points with No prefixes. Any computed Alignments will be 
stored with an SV prefix to represent a Survey-stored Alignment, with the exception of baseline alignments, 
which shall be named after the Roadway Name (see SDE ORD Guidelines for details). The reason that Survey 
(field collected and computed points) do not contain pre-pended prefixes is simply to make it easier to 
distinguish between Survey and Design Points. 

Table 2.3
Standard Survey Geometry Object Names

Object Type Prefix Starting Number

Survey Points Survey (SDE) = No Prefix 1

Survey Non-Baseline Horizontal Alignments SV 1

Survey Baseline Horizontal Alignments
No Prefix.  Named after Roadway 
Name N/A

2.2.2 Standard Geometry Survey and Design Feature Definition Conventions

The following Section details the Feature Definitions used for Survey and Design Objects. When storing Survey 
and Design Geometry Objects, the applicable Feature Definitions must be utilized in order to view the correct 
Feature Symbology, cells, etc. for each of the elements. This ensures that the data conforms to the correct Level 
and Symbology as depicted by the Electronic Data Guidelines and for use in Plans Production utilities.
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2.2.2.1 Survey Feature Definitions for Points and Alignments

The Standard Feature Definitions the SDE uses when storing Points and Alignments for the Existing Baseline 
Alignments, Existing R/W, Property, etc. are named according to the type of Point or Alignment which is to be 
stored. The following Table lists the applicable Feature Definition(s) the SDE (Survey Data Engineer) utilizes 
when storing the Existing Point and Alignment data: (See Table 2.4)

Table 2.4
Feature Definitions for Geometry Survey Points and Alignments

Existing/Computed Points

PROP_E_APC 

PROP_E_API 

PROP_E_APOC 

PROP_E_APOT 

PROP_E_APT 

PROP_E_PCF

PROP_E_RWE-LTD-ACCESS

PROP_E_LTD-ACCESS

PROP_E_POEL 

PROP_E_PPC 

PROP_E_PPOL 

PROP_E_RWC 

PROP_E_RWE 

PROP_E_RWM 

PROP_E_RWRR 

PROP_E_RWU 

Existing Baseline Alignment
Existing R/W Alignment
Existing Property (Parcel) Alignment 
Existing Easement Alignment
Existing R/W & Limited Access
Existing Limited Access

PROP_E_ACL
PROP_E_RWE
PROP_E_PAR
PROP_E_POEL
PROP_E_RWE-LTD-ACCESS
PROP_E_LTD-ACCESS

2.2.2.2 Design Feature Definitions for Points and Alignments

The Standard Feature Definitions to use when storing Design Points and Alignments for the Proposed Baseline 
Alignments, Proposed R/W and Easements, etc. will be named according to the type of Point or Alignment which 
is to be stored. The following Table lists the applicable Feature Definition(s) the Designer utilizes when storing 
Design Points and Alignment data:  (See Table 2.5)
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Table 2.5
Feature Definitions For Geometry Design Points and Alignments

Proposed 
Design Point

Feature Definitions

DRNG_P_Cross Drain and Culvert
DRNG_P_Ditch 
DRNG_P_Storm Drain 
Pipe
MAIN_P_CONSTCL 100/500 
MAIN_P_Driveway
MAIN_P_EOP 
MAIN_P_EPSHLDR 
MAIN_P_SHLDR 

MAIN_P_SIDECL 100/500
REQD_P_DWESMT 
REQD_P_PESMT 
REQD_P_REQD 
REQD_P_RWRM 
REQD_P_TESMT 
STE_P_DETCL 100/500

Proposed Baseline Alignments
Descriptions Feature Definition Feature Name Example

Mainline Baseline – 100’ tick spacing MAIN_P_CONSTCL 100 HWY 100

Mainline Baseline – 500’ tick spacing MAIN_P_CONSTCL 500 HWY 100

Sideroad Baseline – 100’ tick spacing MAIN_P_SIDECL 100 PEQUANOC DR.

Sideroad Baseline – 500’ tick spacing MAIN_P_SIDECL 500 PEQUANOC DR.

Detour Baseline – 100’ tick spacing STE_P_DETCL 100 US 78

Detour Baseline – 500’ tick spacing STE_P_DETCL 500 US 78

Proposed Right of Way
Descriptions Feature Definition Feature Name Example 

R/W Marker REQD_P_RWRM N/A

Reqd. R/W REQD_P_REQD DE52

Perm. Const. Esmt. REQD_P_PESMT DE65

Temp. Const. Esmt. REQD_P_TESMT DE75

Driveway Esmt. REQD_P_DWESMT** DE100

Miscellaneous
Descriptions Feature Definition Feature Name Example

Edge of Pavement MAIN_P_EOP DE40

Edge of Paved Shoulder MAIN_P_EPSHLDR DE41

Edge of Shoulder MAIN_P_SHLDR DE42

Ditch Baseline DRNG_P_Ditch DE45

Other (User-Defined) DE50

** The Feature Definition REQD_P_DWESMT will be used for all other types of easements (that are not 
listed above) and be noted as such on plans by the Engineer.
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2.3 Standard Design Feature Definitions

ORD Feature Definitions are similar to what Feature Styles were in InRoads.  Feature Definitions describe the 
engineering properties of the feature and define how it will display in various contexts (plan, profile, 3D, cross 
section), by pointing to one or more Feature Symbologies.  Feature Symbologies may define Annotation Groups 
and also point to one or more Element Templates.  These Element Templates, in turn, point to a specific Cell 
and/or Level, and therefore define how a feature is displayed.  See the diagram below, which summarizes the 
relationships described above.

These Feature Definitions conform to the Electronic Data Guidelines (still under development) and must be 
utilized to conform to GDOT Standard Conventions for use in Plan Production.

Table 2.6 below shows all of the major categories (and subcategories, if applicable) of Feature Definitions. 
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Table 2.6
Feature Definition 
Type

Feature Definition 
Subcategory

Description

Alignment For baseline alignments only

Terrain Bogus Surface For creating temporary surfaces in obscured areas or outside 
of existing survey limits

Existing Existing Terrain

Finish Proposed Terrain

Corridor For setting Corridor parameters (Concept, Design, Final, etc.)

Superelevation Superelevation

Linear Template Templates applied along linear feature only; often used in Civil 
Cells

Surface Template Templates applied to a Terrain; often used in Civil Cells

Linear Bridge For Linear features (broken up by subcategory)

Draft For non-plotting Linear features

Drainage For Linear features (broken up by subcategory)

Limits For Linear features (broken up by subcategory)

Main For Linear features (broken up by subcategory)

Modeling For Linear features (broken up by subcategory)

Pavement Marking For Linear features (broken up by subcategory)

Profiles For Linear features (broken up by subcategory)

Property For Linear features (broken up by subcategory)

Required For Linear features (broken up by subcategory)

Template Points For Linear features (broken up by subcategory)

Topo For Linear features (broken up by subcategory)

Utilities For Linear features (broken up by subcategory)

Point Detour For Point features (broken up by subcategory)

Drainage For Point features (broken up by subcategory)

Limits For Point features (broken up by subcategory)

Main For Point features (broken up by subcategory)

Property For Point features (broken up by subcategory)

Required For Point features (broken up by subcategory)

Signage For Point features (broken up by subcategory)

Topo For Point features (broken up by subcategory)

Utilities For Point features (broken up by subcategory)
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Feature Definition 
Type

Feature Definition 
Subcategory

Description

Mesh Aggregate For Mesh features (broken up by subcategory)

Asphalt For Mesh features (broken up by subcategory)

Barriers For Mesh features (broken up by subcategory)

Bridge For Mesh features (broken up by subcategory)

Concrete For Mesh features (broken up by subcategory)

Detour For Mesh features (broken up by subcategory)

Drainage For Mesh features (broken up by subcategory)

Grading For Mesh features (broken up by subcategory)

Limits For Mesh features (broken up by subcategory)

Main For Mesh features (broken up by subcategory)

Modeling For Mesh features (broken up by subcategory)

Property For Mesh features (broken up by subcategory)

Required For Mesh features (broken up by subcategory)

Topo For Mesh features (broken up by subcategory)

Utilities For Mesh features (broken up by subcategory)

Volumes For Mesh features (broken up by subcategory)

Analysis Aquaplaning Aquaplaning

Sight Visibility Sight Visibility

Trace Slope Trace Slope

Survey Linear Survey Linear features (Alpha Codes)

Point Survey Point features (Alpha Codes)
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Feature Definition 
Type

Feature Definition 
Subcategory

Description

Node CommunicationsNode Communications points on conduits

ConflictNode Conflict points on conduits

ElectricalNode Electrical points on conduits

GasNode Gas points on conduits

GenericNodeAsset Generic points on conduits

POLNode POL points on conduits

StormWaterNode Storm Water points on conduits

ThermalNode Thermal points on conduits

WasteWaterNode Wastewater points on conduits

WaterNode Water line points on conduits

Conduit CommunicationsSegment Communications conduits

ElectricalSegment Electrical conduits

GasSegment Gas conduits

GenericSegmentAsset Generic conduits

POLSegment POL conduits

StormWater Storm Water conduits (Channels, Circular, Gutters)

ThermalSegment Thermal conduits

WasteWaterSegment Wastewater conduits

WaterSegment Water line conduits

Drainage Area Catchment Catchment drainage areas

Lid Low impact development areas

Pond Pond drainage areas

Surface Polygon Surface Polygons
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These Feature Definitions are used in Design Features, Components and Component Points. Table 2.7 contains 
the applicable Design Feature Definitions to use for Design.

Table 2.7
Feature Definitions -- GDOT Geometry Design Points and Alignments

Feature Definition Description

BRDG_E_Hydraulics Bridge Hydraulics
DRNG_P_Ditch Ditch-Drainage

DRNG_P_Cross Drain and Culvert Cross Drain and Culvert

DRNG_P_Storm Drain Pipe Storm Drain Pipe

LIMT_P_CUT Cut Limits (Assign to End Condition Components)

LIMT_P_CUT_Const-Limit Cut Limits (Assign to LAST Point in the End Condition)

LIMT_P_FILL Fill Limits (Assign to End Condition Components)

LIMT_P_FILL_Const-Limit Fill Limits (Assign to LAST Point in the End Condition)

MAIN_P_Barrier-Median-Side Proposed median or side barrier

MAIN_P_Barrier-Retain-Wall Proposed retaining wall

MAIN_P_Barrier-Sound-Wall Propose sound wall

MAIN_P_CableBarrier Proposed cable barrier

MAIN_P_CONSTCL 100 Proposed Construction baseline 100’ tick spacing

MAIN_P_CONSTCL 500 Proposed Construction baseline 500’ tick spacing

MAIN_P_CROWN Crown Point

MAIN_P_Curb Proposed Curb

MAIN_P_Driveway Driveway

MAIN_P_EOP Proposed Road Edge of Pavement

MAIN_P_EPSHLDR Proposed edge of paved shoulder

MAIN_P_Guardrail Proposed guardrail

MAIN_P_MILLING Milling

MAIN_P_Misc-Const-Feat Proposed misc. construction feature

MAIN_P_OVERLAY Overlay

MAIN_P_SHLDR Proposed Shoulder lines

MAIN_P_SIDECL 100 Proposed Side or Cross road baseline 100’ tick spacing

MAIN_P_SIDECL 500 Proposed Side or Cross road baseline 500’ tick spacing

MAIN_P_Sidewalk Proposed Sidewalk

MAIN_P_Slope-break Proposed Slope Break Location
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Table 2.7
Feature Definitions -- GDOT Geometry Design Points and Alignments

Feature Definition Description

MAIN_P_Transverse Features Transverse Features
MAIN_P_WALL-PROF-Bottom-of-Wall Wall Profile Bottom of Wall
MAIN_P_WALL-PROF-Exist-Grd-TP6 Wall Profile Type 6 Existing Ground line or Backfill Slope Tie-in
MAIN_P_WALL-PROF-Existing-Grd Wall Profile Existing Ground line or Backfill Slope Tie-in
MAIN_P_WALL-PROF-Finish-Grd-BoW Wall Profile Finished Ground line at Back Face of Wall
MAIN_P_WALL-PROF-Finish-Grd-FoW Wall Profile Finished Ground line at Front Face of Wall
MAIN_P_WALL-PROF-Top-of-Footing Wall Profile Top of Footing
MAIN_P_WALL-PROF-Top-of-Wall Wall Profile Top of Wall
REQD_P_DWESMT Required Driveway Easement
REQD_P_PESMT Required Permanent Easement
REQD_P_REQD Required R/W
REQD_P_RWRM Required Right of Way Marker
REQD_P_TESMT Required Temporary Easement
Special Ditch LT Special Ditch Profile LT
Special Ditch RT Special Ditch Profile RT
STE_P_DETCL 100 Proposed Detour baseline 100’ tick spacing
STE_P_DETCL 500 Proposed Detour baseline 500’ tick spacing
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2.4 Standard File Information

Following is a brief overview of the most common ORD file types the Designer will utilize:

Table 2.8

Standard File Information Overview

.DGN
DGN files are the main file types Designers will use in ORD.  All DGN files used by a Designer 
should be created as 2D files, with the exception of the delivered 3D PI#TOPO.dgn.  DGN files 
contain all Design, Survey and Photogrammetric information, including Superelevation, Corridor 
Modeling, Drafting, Field Book/Survey Data, Terrain Models (Existing Ground & Proposed Design 
Surfaces), Photogrammetry feature graphics, Property, Existing R/W, Existing Baseline Alignments, 
Proposed Horizontal/Vertical Alignments and R/W and Easement Alignments, etc.

.ITL
The .ITL is the Template File which contains all of the Templates and Components required to 
produce cross sections. This file is specific to each individual ORD Project.

.XML
These files perform several different functions in ORD, including exporting/importing 
terrains and/or alignments, housing superelevation rules, and more.
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2.5 GDOT Standard ORD Photogrammetric Feature Codes
     

To see the most current GDOT ORD Photogrammetric Features and the Levels used for them, please see the 
ORD Photogrammetric Features document, found on the GDOT ROADS webpage.

2.6 GDOT Standard ORD Field Survey Feature Codes

To see the most current GDOT ORD Survey Feature Codes/Definitions, please see the ORD Field Survey Feature 
Codes document, found on the GDOT ROADS webpage.

http://www.dot.ga.gov/PartnerSmart/DesignSoftware/OpenRoads/OpenRoads%20Photogrammetric%20Features.pdf
http://www.dot.ga.gov/PartnerSmart/DesignSoftware/OpenRoads/OpenRoads%20Field%20Survey%20Feature%20Codes.pdf
http://www.dot.ga.gov/PartnerSmart/DesignSoftware/INROADS/InRoads%20Field%20Survey%20Feature%20Codes.pdf
http://www.dot.ga.gov/PartnerSmart/DesignSoftware/INROADS/InRoads%20Field%20Survey%20Feature%20Codes.pdf
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  Horizontal Alignments
This section provides a brief overview of the requirements for Horizontal Alignments, Points and Curve Tables. 
For generic training on how to place Horizontal Alignments, go through the Bentley Learning Plan: 

00 – Roadway Design Modeling – Fundamentals: Quickstart for Geometry - Road: 
https://learning.bentley.com/learn/learning-plans/614/00-roadway-design-modeling-
fundamentals/courses/678/quickstart-for-geometry-road/lessons.

3.1 Horizontal Alignment Overview

In ORD, the term Horizontal Alignment refers to all linear elements, open or closed, such as baselines, right of 
way parcels, edge of pavements, etc. Horizontal Alignments may consist of design points, linear elements and 
curves. In order to generate Horizontal Alignments to GDOT standard conventions, the following information 
shall be adhered to:

a) All Baseline Horizontal Alignments must have a Feature Definition assigned of either 
MAIN_P_CONSTCL 100, MAIN_P_CONSTCL 500, MAIN_P_SIDECL 100, MAIN_P_SIDECL 
500, STE_P_DETCL 100 or STE_P_DETCL 500 for the correct Feature Symbology and 
Stationing to view correctly.

b) All Right of Way and Easement Alignments must have a Feature Definition assigned of 
either REQD_P_DWESMT, REQD_P_PESMT, REQD_P_REQD or REQD_P_TESMT for the 
Right of Way Tables to generate correctly.

c) Any additional Horizontal Alignments such as Ditch Baselines, Edge of Pavements, etc. 
must be assigned the appropriate Feature Definition for the Feature Symbology and Levels 
to view correctly.

d) All Design Horizontal Alignment Names for Baseline Alignments shall be named for the 
roadway itself (e.g. Roswell Rd-SR 9). Important: these names are used by default during 
the Named Boundary command; therefore, you may want to avoid using the following 
characters in your names because they are not allowed in model names: “\*/?<>|&=’,.

e) All other Design Horizontal Alignment/Point Names must begin with a DE Prefix and a 
unique number (i.e. DE5).

f) Designers should not use the Existing Baseline Alignment provided by Survey as the Design 
Alignment but should instead create a new Design Alignment either by copying and 
renaming the Existing Baseline Alignment and assigning an appropriate Feature Definition 
or by creating a new Design Baseline Alignment from scratch.

g) When working on a Horizontal Alignment – ensure that it is set as the Active Alignment.

https://learning.bentley.com/learn/learning-plans/614/00-roadway-design-modeling-fundamentals/courses/678/quickstart-for-geometry-road/lessons
https://learning.bentley.com/learn/learning-plans/614/00-roadway-design-modeling-fundamentals/courses/678/quickstart-for-geometry-road/lessons
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3.2 Horizontal Alignment and Point Names/Feature Definitions

Horizontal Alignments and Points must be stored with the appropriate Feature Definition. See the Tables 3.1 
and 3.2 for a list of the required naming conventions.

Table 3.1
Object Type Name (example)

*Design Points DE1

**Design Horizontal Alignments (baseline) Roswell Rd-SR 9

**Design Horizontal Alignments (non-baseline) DE1

***Design Vertical Alignments ***As Horizontal Alignment

* All Design Points must be named with a prefix of DE and begin with the number 1 (e.g., first design point = 
DE1).

**All Design Horizontal Alignments for Baselines shall be named for the roadway itself.  Other, non-baseline 
types of Design Horizontal Alignments, shall be named with a prefix of DE and begin with the number 1, (e.g., 
DE1).

***The Design Vertical Alignments (which corresponds with the Horizontal Alignments) shall have the same 
name as the associated Horizontal Alignments, although more descriptors can be added (i.e. Roswell Rd-SR 9 – 
Alternative1).
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Table 3.2
Feature Definitions for Geometry Design Points and Alignments

Proposed Design

Feature Definition

DRNG_P_Ditch 
MAIN_P_CONSTCL 
MAIN_P_EOP 
MAIN_P_EPSHLDR 
MAIN_P_SHLDR 
MAIN_P_SIDECL

REQD_P_DWESMT 
REQD_P_PESMT 
REQD_P_REQD 
REQD_P_RWRM 
REQD_P_TESMT 
STE_P_DETCL

Proposed Baseline Alignments Feature Definition Feature Name Example

Mainline Baseline
MAIN_P_CONSTCL 100
MAIN_P_CONSTCL 500

SR 100

Sideroad Baseline
MAIN_P_SIDECL 100
MAIN_P_SIDECL 500

CR69

Detour Baseline
STE_P_DETCL 100
STE_P_DETCL 500

SR100D

Proposed Right of Way Feature Definition Feature Name Example

R/W Marker REQD_P_RWRM DE2

Reqd. R/W REQD_P_REQD DE2

Perm. Const. Esmt. REQD_P_PESMT DE2

Temp. Const. Esmt. REQD_P_TESMT DE2

Driveway Esmt. REQD_P_DWESMT** DE2

Miscellaneous Feature Definition Feature Name Example

Edge of Pavement MAIN_P_EOP DE2

Edge of Paved Shoulder MAIN_P_EPSHLDR DE2

Edge of Shoulder MAIN_P_SHLDR DE2

Ditch Baseline DRNG_P_Ditch DE2

Other (User-Defined) DE2

** Note: All other Types of Miscellaneous Easements should use the REQD_P_DWESMT Feature Definition.
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3.3 Design/Alignment Points

ORD has the capability to store COGO Points (which are northing and easting coordinates). 
It is a required GDOT standard that all Points used to define Required Right of Way or 
Required Easements must be stored as COGO Points.

3.4 Reviewing Horizontal Alignments

The Horizontal Alignments description can be reviewed and printed by using the OpenRoads 
Modeling workflow, with the Geometry►Reports►Horizontal Geometry Report command.

Ensure you have entered the following items in order to have the desired results using this 
command:

• Ensure that the desired Interval is entered (i.e. 50’).

• Ensure the desired Start and End Stations have been entered.  For the entire 
alignment, simply check both the Lock to Start and Lock to End boxes.

Once the Bentley Civil Report Browser appears, simply select the GDOT Alignment Report Style 
Sheet (see example below).  This can be saved out as a .PDF file by using the File>Print 
command and choosing an available PDF printer driver such as Bluebeam, Adobe, or Microsoft 
Print to PDF.

Figure 3-1 Review Horizontal Alignment

3.5 Curve Table Overview
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In accordance with the GDOT Plan Presentation Guide, Curve Tables are required for each Horizontal Alignment. 
The Curve Tables depict the Curve Data for each curve of the Alignment(s). To view the annotation, simply select 
the alignment element desired to annotate, and use the command Element Annotation>Annotate Element.

Following is the Curve information which is required in all Curve Data Tables:

a) Curve Data Table Required Information
o CURVE Number
o P.I. Station
o P.I. Coordinates
o  or “DELTA” (Deflection angle)
o D (Degree of Curve)
o T (Tangent Length)
o L(Length of Curve)
o R (Radius)
o E (External distance)
o e (Superelevation in percent)
o D.S. (Design Speed)

b) The Level of the Curve Table (MAIN_P_CONSTCL-Curve-Data-Text or MAIN_P_SIDECL-
Curve-Data-Text) are based on the Feature Definition of the Horizontal Alignment and is 
set up automatically in a corresponding Annotation Group.

c) It is the Designer’s responsibility to manually modify each curve table to assign the Curve 
a unique Number for that Alignment. Generally, the first curve on an alignment would be 
Curve #1, the second Curve #2, etc.  In addition, the Design Speed must also be entered 
manually.
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  Vertical Alignments
This section provides a brief overview of the requirements for generating Existing Ground Profiles (Terrain 
Profiles) and Design Vertical Alignments. For generic training on how to create a Vertical Alignment, please go 
through the Fundamentals and Intermediate free training on the Bentley LEARNserver on creating/editing 
Vertical Alignments:

00 - Roadway Design Modeling - Fundamentals
01 - Roadway Design & Modeling - Intermediate

4.1 Vertical Alignment Overview

In ORD the term Vertical Alignment refers to the Proposed Design Profile. A Vertical Alignment is created for each 
associated Horizontal Alignment. A proposed Horizontal Alignment and an Existing Terrain must be available 
(and active) before creating an Existing Profile and a Proposed Vertical Alignment. In order to generate Vertical 
Alignments to GDOT standard conventions, the following information shall be adhered to:

a) All Vertical Alignments should be named the same as the associated Horizontal Alignment. 
Example: Horizontal Alignment = DE7 then the Vertical Alignment should be named DE7.  
For Baselines with multiple vertical alignments, other appropriate suffix descriptors should 
be added to distinguish them.

b) A parent/child relationship exists in ORD between the Horizontal and Vertical Alignments. 
A Vertical Alignment is a child of the Horizontal Alignment. Multiple Vertical Alignments 
may exist for a single Horizontal Alignment -- therefore it is important to have the correct 
Vertical Alignment active along with the active Horizontal Alignment before doing any 
work.

c) There are 8 GDOT Drawing Seed options available.  See Section 4.4 for a list.

d) Use Named Boundary command to generate Profile Sheets.  See Section 15 workflow in 
ORD Workflows for Roadway Design Sheet Creation for instructions.

https://learning.bentley.com/learn/learning-plans/614/00-roadway-design-modeling-fundamentals/courses/678/quickstart-for-geometry-road/lessons
https://learning.bentley.com/learn/learning-plans/617/01-roadway-design-modeling-intermediate
http://www.dot.ga.gov/PartnerSmart/DesignSoftware/OpenRoads/ORD%20Workflows%20For%20Roadway%20Design%20Sheet%20Creation.pdf
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4.2 Vertical Alignment Names and Feature Definitions

Vertical Alignments for baseline alignments should match the roadway name of the Horizontal Alignments, 
although for multiple alternates, more suffix descriptors may be added, as needed (e.g. SR9Alt2).  All other non-
baseline Vertical Alignments shall be stored with a DE Prefix + unique number (i.e. DE1) and should be named 
the same as the associated Horizontal Alignment. Example: Horizontal Alignment = DE7 then the Vertical 
Alignment should be named DE7. The appropriate Feature Definition should be used which corresponds with the 
Horizontal Alignment Feature Definition. (See Table 4.1).

Object Type Name

Vertical Alignment Should match the Horizontal Alignment name as closely 
as possible

Table 4.1
Feature Definitions for Geometry Vertical Alignments

Proposed Vertical Alignment Feature Definition Feature Name Example

Mainline Baseline
MAIN_P_CONSTCL 100
MAIN_P_CONSTCL 500

SR100

Sideroad Baseline
MAIN_P_SIDECL 100
MAIN_P_SIDECL 500

SR100

Detour Baseline
STE_P_DETCL 100
STE_P_DETCL 500

SR100D

Miscellaneous Feature Definition Feature Name Example

Edge of Pavement MAIN_P_EOP DE20

Edge of Paved Shoulder MAIN_P_EPSHLDR DE20

Edge of Shoulder MAIN_P_SHLDR DE20

Ditch Special Ditch LT or Special Ditch RT DE20

Other (User-Defined) DE20
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4.3 Reviewing Vertical Alignments

The Vertical Alignments description can be reviewed and printed by using the OpenRoads 
Modeling workflow, with the Geometry►Reports►Profile Report command.  You can also 
hover over the desired Profile and select the Profile Report button from the context menu.

This will open directly in the Bentley Style Sheet VerticalAlignmentReview (an example is shown below).  This 
can be saved out as a .PDF file by using the File>Print command and choosing an available PDF printer driver 
such as Bluebeam, Adobe, or Microsoft Print to PDF. If the Stations are in feet instead of the familiar SS+SS.SS 
format, simply go to Tools► Format Options and choose ss+ss.ss as the preferred Station format.

Figure 4-1   Review Vertical Alignment
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4.4 Vertical Alignment Drawing Seed Preferences

In order to generate Vertical Alignment/Profile Sheets to GDOT Standards, the appropriate Drawing Seed must 
be set. The Drawing Seed is set in the Named Boundary workflow. (See Table 4.2 below for descriptions of each 
Drawing Seed).  The Profile Sheets will be created as Models inside of the DGN file.  The PDF deliverables will be 
created from these Models.

Table 4.2 Drawing Seeds

Drawing Seed Description
Profile Double Sheet 40h 10v Used for Vertical Alignment Sheet generation for a Double Profile 

with 40 Scale Horizontal and 10 Scale Vertical Sheet.

Profile Double Sheet 100h 20v Used for Vertical Alignment Sheet generation for a Double Profile 
with 100 Scale Horizontal and 20 Scale Vertical Sheet.

Profile Double Sheet USACoE 
100h 10v

Used for Vertical Alignment Sheet generation for a Double Profile of 
Streams at Culvert locations with 100 Scale Horizontal and 10 Scale 
Vertical Sheet.

Profile Driveway 20 Scale Used for Vertical Alignment Sheet generation for a Driveway Profile 
with 20 Scale Vertical Sheet.

Profile Sheet 40h 10v Used for Vertical Alignment Sheet generation for a Single Profile with 
40 Scale Horizontal and 10 Scale Vertical Sheet.

Profile Sheet 100h 20v Used for Vertical Alignment Sheet generation for a Single Profile 
with 100 Scale Horizontal and 20 Scale Vertical Sheet.

Profile Sheet 200h 20v Used for Vertical Alignment Sheet generation for a Single Profile 
with 200 Scale Horizontal and 20 Scale Vertical Sheet.

Profile Sheet USACoE 100h 10v Used for Vertical Alignment Sheet generation for a Single Profile of 
Streams at Culvert locations with 100 Scale Horizontal and 10 Scale 
Vertical Sheet.
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 Components and Template Creation
This section provides a brief overview of the requirements for creating Components and Templates.

5.1 Component and Template Creation Overview

The following section depicts an overview of the components and templates used to generate cross sections in 
ORD. In order to create and utilize GDOT Components and Templates to GDOT standard conventions, the 
following information should be adhered to:

a) The ORD Template Library (.ITL) is where the Designer creates all the Components 
necessary to generate a complete Template such as shoulders, travel lanes, 
barriers, medians and end conditions.

b) The ORD Template Library is included in the 
GDOT_ORD_Civil_Standards_CaddAll.exe file download, as well as the internal 
ProjectWise Workspace. Internally, the Designer will need to copy the latest 
Template Library (GDOT_Standard_CE.itl) from 
Documents\Standards\Civil_Standards\ to their Project Directory in the DGN-CE 
folder and rename the file to GDOT_Design.itl or PI#.itl (Ex. 123456-.itl).  
External users shall use this same file-naming scheme. Please refer to section 
1.3.2 for more details on the file naming.

c) Once the Designer modifies the ITL file and creates the components and templates, this 
file is always submitted as a deliverable with the project so that anyone who works on 
the project will have the Template Library that contains the associated project 
components and templates.

d) There are seven types of Components which can be created: Simple, 
Constrained, Unconstrained, Null Point, End Condition, Overlay/Stripping, 
and Circle.

e) The GDOT Standard ITL file contains the following Component Categories: Barriers, 
Curbs and Gutters, End Conditions, Medians, Shoulders, Sidewalks and Travel Lanes. 
In addition, Linear/Surface Templates are provided for use on Civil Cells.  Finally, 
several full Templates are also provided as a starting point for Designers.

f) The Designer is provided a Point Name List and Feature Definitions to utilize in the 
development and/or modifications to the Components. It is important to use the 
standard GDOT Feature Definitions so that Cross Section Annotation will generate 
correctly. Using already-established Point Names from the GDOT_Standard_CE.itl will 
automatically pick up the correct Feature Definition. Therefore, if new Point Names are 
necessary, it is recommended to use a similar Point Name (if one exists) from the 
standard ITL to get the correct Feature Definition and then change the name. Doing so 
could avoid issues later on.
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5.2 ITL Template Library and Naming Conventions

The ORD Template Library is included in the GDOT_ORD_Civil_Standards_CaddAll.exe file download and also in 
the internal ProjectWise workspace. The Designer will copy the Template Library to the Project Directory and 
rename the file to the following:  (See Table 5.1).

Table 5.1
ITL Naming Convention

GDOT Standard ITL Rename To Example

GDOT_Standard_CE.itl
GDOT_Design.itl or 

PI#.itl [see 1.3.2]
GDOT_Design.itl 
1234567.itl

The project-specific ITL file shall be submitted along with DGN deliverables. It is very important for anyone who 
works on (or inherits) the project to receive the associated ITL file so that they will have access to the same 
Components and Point Names used to create the original Templates.

The Designer may need to add additional Components, Templates and Point Names to the ITL file during the 
course of Project design to cover design situations that are not represented in the Standard GDOT Template 
Library. It is very important that the Designer use the same Feature Definitions as those provided in the ITL. 
Component and Point Names may need to be added but always use one of the provided Feature Definitions 
contained in the Workspace. 

Following is a list of the seven types of components that are provided in ORD:

1. Simple: A Simple Component is a simple prefabricated closed rectangular shape. This is useful 
for the quick setup of rectangular shapes like a travel lane.

2. Constrained: A Constrained Component is placed one point at a time and can be either a closed 
or open shape. It is useful for making objects of differing shapes such as curb and gutter. The 
points in Constrained Components can be set to behave in a particular manner by selection of 
the differing constraint options. The default constraint is set to be Horizontal and Vertical to 
the previous point placed.

3. Unconstrained: An Unconstrained Component is placed one point at a time, the same as a 
Constrained Component, but is placed with no constraint defaults applied.  The constraints of 
points composing both Constrained and Unconstrained Components can be edited after 
placement to apply whatever constraints the user desires.

4. Null Point: Null Point Components are placed unconstrained to other components and are 
typically edited to control the behavior of other points. Null Points can be edited to behave as 
‘Display Switches’ in order to display different components under differing conditions such as 
Type S Barrier switching between the S1, S2 or S3 variations.

5. End Condition: End Condition Components are used to tie to a surface - typically the existing 
surface. Cut/Fill slopes are the typical type components created with End Condition 
Components. End Condition Components can be designed with ditches incorporated and that 
widen for guardrail when certain conditions are met.

6. Overlay/Stripping: Components used for milling/stripping and overlay operations.
7. Circle: Used to create a circular, or elliptical, Component.
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5.3 GDOT Standard Components

GDOT supplies a standard Template Library (ITL) named GDOT_Standard_CE.itl. This Library contains the 
Component Categories: Barriers, Curbs and Gutters, End Conditions, Medians, Shoulders, Sidewalks and Travel 
Lanes. In addition, there are several full Templates provided as starting points for design.  Finally, Linear and 
Surface Templates are included as well, for use on Civil Cells.  The following Table lists the Categories and 
individual components provided in the GDOT_Standard_CE.itl file. (See Table 5.2).

Table 5.2
GDOT Standard Components & Templates

Category Component/Template
Barriers • Bridge Barrier

• Gravity Wall Type A Insertion Back Face
• Gravity Wall Type A Insertion Front Face
• Gravity Wall Type C Insertion Back Face
• Gravity Wall Type C Insertion Front Face
• TP 7 CS Barrier_MASH/LRFD Compliant
• TP 7 WS Barrier_MASH/LRFD Compliant
• TP P1, P2 & P3 Parapet Retaining Wall_ MASH/LRFD Compliant
• TP S1, S2 & S3 Median Barrier_ MASH/LRFD Compliant
• TP T Guardrail w/Plastic block_LT
• TP T Guardrail w/Plastic block_RT
• TP T Guardrail w/Steel block_LT
• TP T Guardrail w/Steel block_RT
• TP W Guardrail_LT
• TP W Guardrail_RT
• TP W Guardrail at Shoulder Edge_LT
• TP W Guardrail at Shoulder Edge_RT
• Type 2S_ MASH/LRFD Compliant
• Type 6S_ MASH/LRFD Compliant

Curb and Gutter • 9032B TP 2 CURB & GUTTER
• 9032B TP 2 DOWELED INTEGRAL CURB
• 9032B TP 2 HEADER CURB
• 9032B TP 7 CURB & GUTTER
• 9032B TP 7 DOWELED INTEGRAL CURB
• 9032B TP 7 HEADER CURB

End Conditions • Combined
o GA Cut Fill_LT
o GA Cut Fill_RT

• Cut
o Cut_Flat
o Cut_Flat w/Ditch
o Cut_Steep

• Fill
o Fill_Flat
o Fill_Steep w/Guardrail_LT
o Fill_Steep w/Guardrail_RT
o Fill_Steep w/Guardrail at Shoulder Edge_LT
o Fill_Steep w/Guardrail at Shoulder Edge_RT
o Fill_Steep w/Shoulder
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Table 5.2
GDOT Standard Components & Templates

Category Component/Template
Medians • 9032B Concrete Median 4” Thk MBCL

• MedianFBD-Low

Shoulders • Asphalt
o Asphalt Inside Shldr Drainage Course Overlap Rural
o Asphalt Inside Shldr Drainage Course Overlap Urban
o Asphalt Outside Shldr Drainage Course Overlap
o Asphalt Safety Edge
o Asphalt Shldr Aggregate Base Course
o Asphalt Shldr Base Course
o Asphalt Shldr Extension Base
o Asphalt Shldr Extension Surface
o Asphalt Shldr Intermediate Course
o Asphalt Shldr Surface Course

• Combined
o Asphalt
▪ Asphalt Shldr Extension to Guardrail Face
▪ Asphalt Shoulder – Full Depth
▪ Asphalt Shoulder – Partial Depth

o Concrete
▪ Concrete Shoulder - Full Depth

• Concrete
o Concrete Safety Edge
o Concrete Shldr Aggregate Base Course
o Concrete Shldr Aggregate Base Course Extension
o Concrete Shldr Intermediate Course
o Concrete Shldr Intermediate Course Extension
o Concrete Shldr Surface Course

• Finish Graded Shoulder

Sidewalks • 5' Grass Strip
• 5’ Sidewalk

Travel Lanes • Asphalt
o Asphalt Aggregate Base Course
o Asphalt Base Course
o Asphalt Drainage Course
o Asphalt Intermediate Course
o Asphalt Surface Course

• Combined
o Asphalt
▪ Asphalt Travel Lanes Full Depth
▪ Asphalt Travel Lanes Full Depth w/Drainage Course
▪ Asphalt Travel Lanes Full Depth w/Shoulders

o Concrete
▪ Concrete Full Depth
▪ Concrete Full Depth w/Shoulders

• Concrete
o Concrete Aggregate Base Course
o Concrete Intermediate Course
o Concrete Surface Course
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Table 5.2
GDOT Standard Components & Templates

Category Component/Template
Linear 
Templates

• Basins
o Berm

• Bridge-Items
o Bridge End
o Fill_Steep

• Connector
o CG Type2 w/Buffer w/EC
o Open Shld (Pvd) w/EC

• Curb Ramps
o Curb Type 2 (Header)
o Curb Type 2 (Header) w CBT
o Curb Type 2 (SW)
o Curb Type 2 (SW)1
o Fill_Flat
o Shld

• Drives
o Curb Type 2 (Header)
o Curb Type 2 (Transition)
o EC-CutFill
o Grass Buffer w-EC
o Gutter

• Interchange
o Asphalt Ramp (Fill Only LT)
o Asphalt Ramp (Fill Only RT)
o Fill_Flat
o Ramp Shld w/EC
o Shld Only- Shld Drop
o Shld w-Fill_Flat
o Turn Lane - Open Shld (PVD) 

w/EC

• Medians
o Asphalt Shoulder with EC
o CG Type 2
o CG Type 7
o Curb Type 2 (Header)
o Curb Type 7 (Header)
o Turn Lane - C&G Type 2_Median
o Turn Lane - C&G Type 7_Median
o Turn Lane - Open Shld (Flat Bottom DCH)
o Turn Lane - Open Shld (for U-Turn 

Widening)
o Turn Lane - Open Shld (V DCH)

• Roundabouts
o CG Type2 w/Buffer w/EC
o CG Type2 w/Buffer w/SW w/EC
o Curb Type7 (Header)
o Rotary w/Truck Apron /No EC

• T-Intersections
o CG Type2 w/Buffer w/EC
o CG Type2 w/Buffer w/SW w/EC
o Curb Type 2 (Header)
o Curb Type 7 (Header)
o Open Shld (Pvd) w/EC
o Open Shld w/EC
o Overlay & Mill
o Turn Lane - CG Type 2 w/Buffer w/SW
o Turn Lane - CG Type 2 w/SW
o Turn Lane - Open Shld (PVD) w/EC

Surface 
Templates

• 9032B Concrete Median 4" Thk 
MBCL

• Asphalt Pavement
• Bridge End
• Drive Asphalt

• Drive Concrete
• GrassBuffer
• Shld
• Sidewalk



ORD Design Guidelines

5. Component/Template Creation

Page 48

Table 5.2
GDOT Standard Components & Templates

Category Component/Template

Templates • Bridge
o Bridge Deck w/Barrier

• Ramp
o Asphalt Ramp
o Concrete Ramp

• Rural
o Divided
▪ Rural Arterial w/Median/Paved Shoulder

o Undivided
▪ Rural Local Roadway
▪ Rural Local Roadway w/Paved Shoulder

• Urban
o Asphalt

▪ Divided
➢ Asphalt Urban Interstate

▪ Undivided
➢ Urban Local Asphalt Roadway with Bike Lanes/Planter/Sidewalk
➢ Urban Local Asphalt Roadway with Buffer/Sidewalk
➢ Urban Local Asphalt Roadway with Sidewalk

o Concrete
▪ Divided
➢ Concrete Urban Interstate

▪ Undivided
➢ Urban Local Concrete Roadway with Bike Lanes/Planter/Sidewalk
➢ Urban Local Concrete Roadway with Buffer/Sidewalk
➢ Urban Local Concrete Roadway with Sidewalk
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5.4 GDOT Standard Point Names

The GDOT_Standards_CE.itl Library contains the Component Categories: Barriers, Curbs and Gutters, End 
Conditions, Medians, Shoulders, Sidewalks and Travel Lanes. Each of the Components listed in the previous 
Table 5.2 contain individual Component Points. The following Table lists the Component Points which compose 
each of these Components.  (See Table 5.3).
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Table 5.3
GDOT Component Points

Point Name Point Name Description Feature Definition

Category: Barriers
BFG_2S Barrier tie to finish grade for Type 2S TL_Barrier Fnsh Grd Tie 2S
BFG_6S Barrier tie to finish grade for Type 6S TL_Barrier Fnsh Grd Tie 6S
BFIB Barrier inside face footing bottom TL_Barrier Ftg In Btm
BFIT Barrier inside face footing top TL_Barrier Ftg In top
BFKIB Barrier inside face footing key bottom for Type 6S TL_Barrier Ftg Key In Btm (6S-6SC)
BFKIT Barrier inside face footing key top TL_Barrier Ftg Key In Top
BFKOB Barrier outside face footing key bottom TL_Barrier Ftg Key Out Btm
BFKOT Barrier outside face footing key top TL_Barrier Ftg Key Out Top
BFOB Barrier outside face footing bottom TL_Barrier Ftg Out Btm
BFOT Barrier outside face footing top TL_Barrier Ftg Out Top (2S-2SC)
BIB Barrier inside face bottom TL_Barrier In Btm
BIM Barrier inside face middle point TL_Barrier In Mid
BIT Barrier inside face top TL_Barrier In Top
BM_S1 Median barrier pay item S1 TL_Barrier Med S1
BM_S2 Median barrier pay item S2 TL_Barrier Med S2
BMB Median barrier bottom TL_Barrier Med Btm
BMFB Median barrier footing bottom TL_Barrier Med Ftg Btm (S3-S3B)
BMFT Median barrier footing top TL_Barrier Med Ftg Top
BMGSB Median barrier glare screen bottom TL_Barrier Med Glare Scr Btm
BMGST Median barrier glare screen top TL_Barrier Med Glare Scr Top
BMGS_SW Median barrier glare screen switch TL_Draft-DNC
BMM Median barrier mid point TL_Barrier Med Mid
BMT Median barrier top TL_Barrier Med Top
B-NP Type 2S/6S project to surface point TL_Draft-DNC
BOB Barrier outside face bottom TL_Barrier Out Btm
BOT Barrier outside face top TL_Barrier Out Top
B-SW Type 2S/6S switch for end condition TL_Draft-DNC
BXG Barrier tie to existing grade TL_Barrier Exst Grd Tie (6S & 6S1)
GPB Guardrail Post bottom TL_Guardrail
GR Guardrail TL_Guardrail
GRL Guardrail Location Insertion Point TL_Guardrail Line
GRPI Guardrail Post Intersection TL_Guardrail
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Table 5.3
GDOT Component Points

Point Name Point Name Description Feature Definition

Category: Barriers (con.)
WGB0 Gravity wall inside face bottom TL_Wall Gravity In Btm
WGB1 Gravity wall outside face bottom TL_Wall Gravity Out Btm
WGFG Gravity wall tie to finish grade TL_Wall Gravity Fnsh Grd Tie
WGM Gravity wall middle point TL_Wall Gravity Mid
WGS Gravity Wall switch for slope tie-in TL_Draft-DNC
WGT0 Gravity wall inside face top TL_Wall Gravity In Top
WGT1 Gravity wall outside face top TL_Wall Gravity Out Top
WGXG Gravity wall tie to existing ground-project to surface pt. TL_Wall Gravity Exst Grd Tie
WP-NP Parapet retaining wall project to surface point TL_Draft-DNC
WPFG Parapet retaining wall tie to finish grade - back of wall TL_Wall Par Ret Fnsh Grd Tie
WPFIB Parapet retaining wall inside face footing bottom TL_Wall Par Ret Ftg In Btm
WPFIT Parapet retaining wall inside face footing top TL_Wall Par Ret Ftg In Top
WPFOB Parapet retaining wall outside face footing bottom TL_Wall Par Ret Ftg Out Btm
WPFOT Parapet retaining wall outside face footing top TL_Wall Par Ret Ftg Out Top
WPIB Parapet retaining wall inside face bottom TL_Wall Par Ret In Btm
WPIT Parapet retaining wall inside face top TL_Wall Par Ret In Top
WPOB Parapet retaining wall outside face bottom TL_Wall Par Ret Out Btm
WPOT Parapet retaining wall outside face top TL_Wall Par Ret Out Top
WPXG Parapet retaining wall tie to existing grade - front of wall TL_Wall Par Ret Exst Grd Tie
W-SW Parapet retaining wall switch for end condition TL_Draft-DNC
Category:  Curbs and Gutters
CBB Curb back bottom TL_Curb Back Btm
CBT Curb back top TL_Curb Back Top
CFB Curb front bottom TL_Curb Front Btm
CFCB Curb face bottom TL_Curb Face Btm
CFD Curb face depth TL_Curb Face Btm
CFT Curb face top TL_Curb Face Top
CFT Curb face top for Type 9032B Header TP2/7 TL_Curb Face Top 9032B Header TP2/7
CGFL Curb gutter flow line for Type 9032B TP2/7 6" TL_Curb Face Flow 9032B TP2/7 6in
CGFL Curb gutter flow line for Type 9032B Dowel TP2/7 TL_Curb Face Flow 9032B Dowel TP2/7
Category:  End Conditions
EC_CUT1,3 Limit of cut point (Feature Name Override: EC_CUT) TL_End Cond Cut
EC_CUT,2 Continuous Cut limit (Feature Name Override: LOC) TL_End Cond LOC
EC_DITCH_IN,1-3 Ditch fore slope pt. (Feature Name Override: 

EC_DITCH_IN)
TL_End Cond Ditch In

EC_DITCH_OUT,3 Ditch back slope pt (Feature Name Override: 
EC_DITCH_OUT)

TL_End Cond Ditch Out
EC_DITCH_OUT1,4 Ditch Cut Continuous Limit pt (Feature Name Override: 

LOC)
TL_End Cond LOC

EC_DITCH_OUT2,5 Ditch Cut Limit pt (Feature Name Override: 
EC_DITCH_OUT)

TL_End Cond Cut
EC_FILL_FLT Con. Limit of flat fill pt (3:1 or flatter) (Name Override: 

LOC)
TL_End Cond LOC
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Table 5.3
GDOT Component Points

Point Name Point Name Description Feature Definition

Category: End Conditions (con.)
EC_FILL_FLT1 Limit of flat fill point (3:1 or flatter) TL_End Cond Fill
EC_FILL_STP Con. Limit of steep fill pt (2:1 or steeper) 

(Name Override: LOC)
TL_End Cond LOC

EC_FILL_STP1 Limit of steep fill point (2:1 or steeper) TL_End Cond Fill
Category: Medians
MB Median edge bottom TL_Median Btm (9032B 4in)
MCL0 Median baseline top TL_Median Baseline Top
MCL1 Median baseline bottom TL_Median Baseline Btm
MDB Median ditch bottom TL_Median Ditch Btm
MDCL Median ditch baseline TL_Ditch Baseline
MDT Median ditch top TL_Median Ditch Top
MT Median edge top TL_Median Top
Category: Pavement Marking
PM10W3-9 Pavt Marking 10" White 3' - 9' TL_Pavt Marking 10" White 3' - 9'
PM10WC6-6 Pavt Marking 10" White w/Contrast 6' - 6' TL_Pavt Marking 10" White w/Contrast 6' - 6'
PM10WS Pavt Marking 10" White Solid TL_Pavt Marking 10" White Solid
PM12WS Pavt Marking 12" White Solid TL_Pavt Marking 12" White Solid
PM18W2-2 Pavt Marking 18" White 2' - 2' TL_Pavt Marking 18" White 2' - 2'
PM24WC2-2 Pavt Marking 24" White w/Contrast 2' - 2' TL_Pavt Marking 24" White w/Contrast 2' - 2'
PM24WS Pavt Marking 24" White Solid TL_Pavt Marking 24" White Solid
PM5W10-30 Pavt Marking 5" White 10' - 30' TL_Pavt Marking 5" White 10' - 30'
PM5W10-30R Pavt Marking 5" White 10' - 30' w/Ref TL_Pavt Marking 5" White 10' - 30' w/Ref
PM5W2-4 Pavt Marking 5" White 2' - 4' TL_Pavt Marking 5" White 2' - 4'
PM5W2-6 Pavt Marking 5" White 2' - 6' TL_Pavt Marking 5" White 2' - 6'
PM5W3-9 Pavt Marking 5" White 3' - 9' TL_Pavt Marking 5" White 3' - 9'
PM5WC20-20 Pavt Marking 5" White w/Contrast 20' - 20' TL_Pavt Marking 5" White w/Contrast 20' - 20'
PM5WC6-6 Pavt Marking 5" White w/Contrast 6' - 6' TL_Pavt Marking 5" White w/Contrast 6' - 6'
PM5WDSR Pavt Marking 5" White Double Solid w/Ref TL_Pavt Marking 5" White Double Solid w/Ref
PM5WS Pavt Marking 5" White Solid TL_Pavt Marking 5" White Solid
PM5Y10-30 Pavt Marking 5" Yellow 10' - 30' TL_Pavt Marking 5" Yellow 10' - 30'
PM5Y10-30R Pavt Marking 5" Yellow 10' - 30' w/Ref TL_Pavt Marking 5" Yellow 10' - 30' w/Ref
PM5YDS Pavt Marking 5" Yellow Double Solid TL_Pavt Marking 5" Yellow Double Solid
PM5YDSR Pavt Marking 5" Yellow Double Solid w/Ref TL_Pavt Marking 5" Yellow Double Solid w/Ref
PM5YS Pavt Marking 5" Yellow Solid TL_Pavt Marking 5" Yellow Solid
PM5YSdLSkR10-
30

Pavt Marking 5" Yellow Solid Lt Skip Rt 10' 
- 30'

TL_Pavt Marking 5" Yellow Solid Lt Skip Rt 10' - 
30'PM5YSkLSdR10-

30
Pavt Marking 5" Yellow Skip Lt Solid Rt 10' 
- 30'

TL_Pavt Marking 5" Yellow Skip Lt Solid Rt 10' - 
30'PM6W10-30 Pavt Marking 6" White 10' - 30' TL_Pavt Marking 6" White 10' - 30'

PM6W10-30R Pavt Marking 6" White 10' - 30' w/Ref TL_Pavt Marking 6" White 10' - 30' w/Ref
PM6W2-4 Pavt Marking 6" White 2' - 4' TL_Pavt Marking 6" White 2' - 4'
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Table 5.3
GDOT Component Points

Point Name Point Name Description Feature Definition

Category: Pavement Marking (con.)
PM6W2-6 Pavt Marking 6" White 2' - 6' TL_Pavt Marking 6" White 2' - 6'
PM6WDSR Pavt Marking 6" White Double Solid w/Ref TL_Pavt Marking 6" White Double Solid w/Ref
PM6WS Pavt Marking 6" White Solid TL_Pavt Marking 6" White Solid
PM6Y2-6 Pavt Marking 6" Yellow 2' - 6' TL_Pavt Marking 6" Yellow 2' - 6'
PM6YDS Pavt Marking 6" Yellow Double Solid TL_Pavt Marking 6" Yellow Double Solid
PM6YDSR Pavt Marking 6" Yellow Double Solid w/Ref TL_Pavt Marking 6" Yellow Double Solid w/Ref
PM6YS Pavt Marking 6" Yellow Solid TL_Pavt Marking 6" Yellow Solid
PM6YSdLSkR10-30 Pavt Marking 6" Yellow Solid Lt Skip Rt 10' - 

30'
TL_Pavt Marking 6" Yellow Solid Lt Skip Rt 10' - 30'

PM6YSkLSdR10-30 Pavt Marking 6" Yellow Skip Lt Solid Rt 10' - 
30'

TL_Pavt Marking 6" Yellow Skip Lt Solid Rt 10' - 30'
PM8W10-10 Pavt Marking 8" White 10' - 10' TL_Pavt Marking 8" White 10' - 10'
PM8W6-3 Pavt Marking 8" White 6' - 3' TL_Pavt Marking 8" White 6' - 3'
PM8WS Pavt Marking 8" White Solid TL_Pavt Marking 8" White Solid
PM8YS Pavt Marking 8" Yellow Solid Pavt Marking 8" Yellow Solid

Category: Shoulders
EIS-1 Edge of inside shoulder layer -1 (drainage 

course)
TL_Inside Shldr -1

EIS0 Edge of inside shoulder top TL_Inside Shldr Top
EIS1 Edge of inside shoulder layer 1 TL_Inside Shldr 1
EIS2 Edge of inside shoulder layer 2 TL_Inside Shldr 2
EIS3 Edge of inside shoulder layer 3 TL_Inside Shldr 3
EIS4 Edge of inside shoulder layer 4 TL_Inside Shldr 4
EIS_OVRLAP Drainage Course Inside shoulder overlap 

wedge pt
TL_Pvd Shldr Top

EOS Edge of shoulder TL_Edge of Shldr
EPS-1 Edge of paved shoulder layer -1 (drainage 

course)
TL_Pvd Shldr -1

EPS0 Edge of paved shoulder top TL_Pvd Shldr Top
EPS1 Edge of paved shoulder layer 1 TL_Pvd Shldr 1
EPS2 Edge of paved shoulder layer 2 TL_Pvd Shldr 2
EPS3 Edge of paved shoulder layer 3 TL_Pvd Shldr 3
EPS4 Edge of paved shoulder layer 4 TL_Pvd Shldr 4
EPS_EXT0 Curb gutter flow line for Type 9032B Dowel 

TP2/7
TL_Ext Pvd Shldr Top

EPS_EXT1 Drainage Course Outside shoulder overlap 
wedge pt

TL_Ext Pvd Shldr 1
EPS_EXT2 Ditch fore slope point TL_Ext Pvd Shldr 2
EPS_OVRLAP Drainage Course Outside shoulder overlap 

wedge pt
TL_Pvd Shldr Top

IS-1 Edge of inside shoulder layer -1 (drainage 
course)

TL_Inside Shldr -1
IS0 Edge of inside shoulder top TL_Inside Shldr Top
IS1 Edge of inside shoulder layer 1 TL_Inside Shldr 1
IS2 Edge of inside shoulder layer 2 TL_Inside Shldr 2
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Table 5.3
GDOT Component Points

Point Name Point Name Description Feature Definition

Category: Shoulders (con.)
IS3 Edge of inside shoulder layer 3 TL_Inside Shldr 3
IS4 Edge of inside shoulder layer 4 TL_Inside Shldr 4
OGS Outside graded shoulder TL_Edge of Shldr
PW Asphalt Pavement Wedge point TL_Pvmt Wedge
SE0 Concrete Safety edge at paved shoulder EOP top TL_Safety Edge
SE1 Concrete Safety edge at paved shoulder EOP bottom TL_Safety Edge 1
Category: Sidewalks
SWB0 Sidewalk Back Top TL_Sidewalk Back Top
SWB1 Sidewalk Back Btm TL_Sidewalk Back Btm
SWF0 Sidewalk Front Top TL_Sidewalk Front Top
SWF1 Sidewalk Front Btm TL_Sidewalk Front Btm
Category: Travel Lanes
EP-1 Outside edge of roadway layer -1 (drainage course) TL_Edge of Pvmt -1
EP0 Outside edge of roadway layer top TL_Edge of Pvmt Top
EP1 Outside edge of roadway layer 1 TL_Edge of Pvmt 1
EP2 Outside edge of roadway layer 2 TL_Edge of Pvmt 2
EP3 Outside edge of roadway layer 3 TL_Edge of Pvmt 3
EP4 Outside edge of roadway layer 4 TL_Edge of Pvmt 4
IEP-1 Inside edge of roadway layer -1 (drainage course) TL_Edge of Pvmt -1
IEP0 Inside edge of roadway layer top TL_Edge of Pvmt Top
IEP1 Inside edge of roadway layer 1 TL_Edge of Pvmt 1
IEP2 Inside edge of roadway layer 2 TL_Edge of Pvmt 2
IEP3 Inside edge of roadway layer 3 TL_Edge of Pvmt 3
IEP4 Inside edge of roadway layer 4 TL_Edge of Pvmt 4
LANE-1 Lane line within the roadway layer -1 (drainage 

course)
TL_Lane Line -1

LANE0 Lane line within the roadway layer Top TL_Lane Line Top
LANE1 Lane line within the roadway layer 1 TL_Lane Line 1
LANE2 Lane line within the roadway layer 2 TL_Lane Line 2
LANE3 Lane line within the roadway layer 3 TL_Lane Line 3
LANE4 Lane line within the roadway layer 4 TL_Lane Line 4
PE1 Outer limit of roadway layer extension 1 TL_Pvmt Ext 1
PE2 Outer limit of roadway layer extension 2 TL_Pvmt Ext 2
PE3 Outer limit of roadway layer extension 3 TL_Pvmt Ext 3
PGL-1 Profile grade line of roadway layer -1 (drainage 

course)
TL_Profile Grade Line -1

PGL0 Profile grade line of roadway layer top TL_Profile Grade Line Top
PGL1 Profile grade line of roadway layer 1 TL_Profile Grade Line 1
PGL2 Profile grade line of roadway layer 2 TL_Profile Grade Line 2
PGL3 Profile grade line of roadway layer 3 TL_Profile Grade Line 3
PGL4 Profile grade line of roadway layer 4 TL_Profile Grade Line 4
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5.5 GDOT Standard Feature Definitions

The GDOT_Standard_CE.itl Library has standard GDOT Feature Definitions applied to all Components and 
Component Points in each template, summarized in Table 5.4 below:

Table 5.4
GDOT Feature Definitions for Components

Feature Definition Description
(Category: Barriers)
TC_Barrier 2S Type 2S Barrier
TC_Barrier 6S-6S1 Bridge barrier and Type 6S-6S1 Barrier
TC_Barrier Cut Type 6S Cut End Cond & Type 2S Barrier Footing Earthwork helper
TC_Barrier Fill Fill End Condition on Type 2S Barrier
TC_Barrier Ftg TP 2S-2SC Type 2S to 2SC Barrier Footings
TC_Barrier Ftg TP 6S-6SC Type 6S to 6SC Barrier Footings
TC_Barrier Med Glare Scr Median Barrier Glare Screen
TC_Barrier Med TP S1-S3 Median Barrier TP S1 to S3
TC_Barrier Med Ftg TP S3HL Median Barrier Footing TP 3 High Left
TC_Barrier Med Ftg TP S3HR Median Barrier Footing TP 3 High Right
TC_Barrier Med Ftg TP S3AHL Median Barrier Footing TP 3A High Left
TC_Barrier Med Ftg TP S3AHR Median Barrier Footing TP 3A High Right
TC_Barrier Med Ftg TP S3BHL Median Barrier Footing TP 3B High Left
TC_Barrier Med Ftg TP S3BHR Median Barrier Footing TP 3B High Right
TC_Barrier TP 7CS Barrier TP 7 CS
TC_Barrier TP 7WS Barrier TP 7 WS
TC_Guardrail Beam Guardrail Beam
TC_Guardrail Block Guardrail Block
TC_Guardrail Post Guardrail Post
TC_Wall Gravity Gravity Wall Types A or C
TC_Wall Parapet Cut Earthwork helper on outside footing
TC_Wall Parapet Fill Fill End Condition on Parapet Retaining Wall
TC_Wall Parapet Ret TP P1-P3 Parapet Retaining Wall
TC_Wall Parapet Ret Ftg P1-P3B TP P1-P3 Parapet Retaining Wall 
(Category: Curbs and Gutters)
TC_Curb 9032B Curb TP 2/7
(Category: Grading/End Conditions)
TC_Cutslope Cut End Conditions
TC_Draft-DNC Tie-ins to ensure no gaps in construction limits in corridor modeling
TC_Fillslope Fill End Conditions
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Table 5.4
GDOT Feature Definitions for Components

Feature Definition Description
(Category: Medians)
TC_Ditch Median Ditch
TC_Median 9032B 4in Concrete Median 9032B 4” thick
(Category: Shoulders)
TC_Asph Pvd Shldr Aggr Asphalt Paved Shoulder Aggregate Course
TC_Asph Pvd Shldr Base Asphalt Paved Shoulder Base Course
TC_Asph Pvd Shldr Int Asphalt Paved Shoulder Intermediate Course
TC_Asph Pvd Shldr Top Asphalt Paved Shoulder Surface/Drainage Course & Safety Wedge
TC_Conc Pvd Shldr Top Concrete Paved Shoulder Surface Course & Concrete Safety Wedge
TC_Conc Pvd Shldr Aggr Concrete Paved Shoulder Aggregate Base Course
TC_Conc Pvd Shldr Int Concrete Paved Shoulder Intermediate Course
TC_Shldr Finished Graded Shoulder
(Category: Sidewalks)
TC_Shldr Grass Strip
TC_Sidewalk Sidewalk
(Category: Travel Lanes)
Median Barrier Footing TP 3A High RightTC_Asph Pvmt Aggr Asphalt Aggregate Base Course
TC_Asph Pvmt Base Asphalt Base Course
TC_Asph Pvmt Int Asphalt Intermediate Course
TC_Asph Pvmt Top Asphalt Surface/Drainage Course
TC_Conc Pvmt Aggr Concrete Aggregate Base Course
TC_Conc Pvmt Int Concrete Intermediate Course
TC_Conc Pvmt Top Concrete Surface Course
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5.6 GDOT Template Help Files (UNDER DEVELOPMENT)

Help Files have been created for each of the GDOT Components and Templates. These Help Files are included in 
the GDOT ProjectWise Workspace, as well as the GDOT_Org_Civil_Standards_CaddAll.exe executable for 
consultants. When installed, Help Files are downloaded to the following location (note, that the drive letter can 
be changed during the unzipping process):

C:\GDOT_CE\Organization-Civil\GDOT_Org_Civil_Standards\Template Library\Documentation\ 

These Help Files provide detailed information regarding the composition of the Component/Template, the 
Default Parameters, Graphic representation and the Component Points/Feature Definitions which are utilized in 
the Component.

When inserting the Components or Templates in the Create Template dialog, the user may access the Help Files 
to assist in the design of the templates. Following is information on how to access these Help Files from the 
Create Template dialog.

➢ In the Create Template dialog - Right mouse click over any component and select 
Template Documentation Link… as shown here.

➢ In the Template Documentation Link dialog – either click the Open Link button if it has already 
been saved, or in the case of consultants, browse to the desired location to save for users to 
access.  The location will be saved for future use.
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5.7 GDOT Civil Cells

Civil Cells specific to GDOT have been provided to model either repetitive tasks, such as driveways, or other 
features, such as Roundabouts or T-Intersections.  Civil Cells use Linear and Surface Templates, listed in Table 
5.2.  Unless you are only using a few Civil Cells (~10 or less), these should generally be placed in a separate .DGN 
file. See Table 5.5 for example file names. Placing Civil Cells in their own .dgn file does present challenges, as you 
cannot clip a corridor that is referenced, but it will help in the processing time of the corridor.  If using ~10 or 
fewer Civil Cells, these may be placed in the appropriate Corridor .dgn file. The number used/file is general 
guidance and may differ based on which Civil Cells are used or how large your Corridor file is that may be 
including a particular Civil Cell in. If you experience issues with processing, splitting your Civil Cells into separate 
files may help.

Listed below in Table 5.5 are all GDOT Civil Cells.  Links to video documentation on how to insert/use these civil 
cells may be found here: 
http://www.dot.ga.gov/PartnerSmart/DesignSoftware/OpenRoads/GDOT%20OpenRoads%20Designer%20(ORD)
%20Civil%20Cell%20Videos.pdf.

Table 5.5

Civil Cell DGNLIB Civil Cell
File Name Examples 
(Logical Name CORD#)

GDOT_Basin Sediment Detention Pond – 4’ 
depth

PI#CCEL_Basin#.dgn
GDOT_BridgeItems Bridge EndRoll PI#CCEL_EndRoll#.dgn

Connector - RuralGDOT_Connector
Connector - Urban

PI#CCEL_Connector_RoadName.dgn

Cul-de-Sac (Rural)GDOT_Cul-de-Sac
Cul-de-Sac (Urban)

PI#CCEL_CuldeSac_RoadName.dgn

Curb Ramp – Type A
Curb Ramp – Type B – LT Side
Curb Ramp – Type B – RT Side
Curb Ramp – Type B or C - 
LandingCurb Ramp – Type C – LT Side
Curb Ramp – Type C – RT Side
Curb Ramp – Type D
Curb Ramp – Skewed - LT

GDOT_CurbRamps

Curb Ramp – Skewed - RT

PI#CCEL_CurbRamps.dgn

Drive – Rural
Drive – Urban
Drive – Urban (Tapered)
Drive – Urban (Tapered w-SW)

GDOT_Drives

Drive – Urban (Variable Radius)

PI#CCEL_Drives.dgn

Ramp – Entrance
Ramp – Exit - Parallel
Ramp – Exit - Tapered
Turn Lane – Entrance – Tapered

GDOT_Interchange

Turn Lane – Exit – Tapered

PI#CCEL_Interchange_CrossRoadName.dgn

http://www.dot.ga.gov/PartnerSmart/DesignSoftware/OpenRoads/GDOT%20OpenRoads%20Designer%20(ORD)%20Civil%20Cell%20Videos.pdf
http://www.dot.ga.gov/PartnerSmart/DesignSoftware/OpenRoads/GDOT%20OpenRoads%20Designer%20(ORD)%20Civil%20Cell%20Videos.pdf


ORD Design Guidelines

6. Corridor Creation

Page 59

Table 5.5 (con.)

Civil Cell DGNLIB Civil Cell
File Name Examples 
(Logical Name CORD#)

Median Turn Lane (Rural)
Median Turn Lane (Urban)
Median X-Over (Type A) (Rural) (3-Center)
Median X-Over (Type A) (Urban) (3-Center)
Median X-Over (Type B or C) (Rural) (Simple Curve)
Median X-Over (Type B or C) (Urban) (Simple Curve)
Raised Median
RCUT

GDOT_Medians

U-Turn Add’l Pave Width

PI#CCEL_Median_RoadName.dgn

Approach (Basic)
Approach (Deflection LT)
Bypass Lane
Curb Cut Ramp
Ramp (Deflection LT)
Ramp (Deflection RT)
Rotary (Placed on Alignments)
Rotary (Placed on Shape)
Splitter Island
Splitter Island w-Curb Cut Ramp
Splitter Median

GDOT_Roundabouts

Splitter Median w-Curb Cut Ramp

PI#CCEL_RndAbt_RoadName(s).dgn

Basic T (Rural)
Basic T (Rural) – Overlay & Widen
Basic T (Urban)
Basic T (Urban) – Overlay & Widen
Island – LT
Island – RT
Island – Single
Median Nose
Median Turn Lane (2D)
Turn Lane – Rural Entrance
Turn Lane – Rural Exit
Turn Lane – Urban Entrance

GDOT_T-Intersections

Turn Lane – Urban Exit

PI#CCEL_T_Int_RoadName.dgn
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 Corridor Creation
This section provides a brief overview of the requirements for creating Corridors in ORD.  A Corridor is necessary 
in order to generate Cross Sections.  Generic Bentley training is available on how to create/manipulate Corridors 
and define Superelevation. 

6.1 Corridor Creation Overview

The following section depicts an overview of the Corridor Creation process used to generate cross sections in 
ORD. In order to create corridors to GDOT standard conventions, the following information shall be adhered to:

a) Corridors should be limited to roughly 1 mile in length.  If a baseline alignment is longer 
than 1 mile, the corridor needs to be split up into lengths of about 1 mile each, in order to 
help speed up data/graphics processing.  The DGN file/s should be named according to the 
standard conventions explained in Section 6.3 below.  Corridors may be split into separate 
dgn files, if so desired, which may help facilitate multiple designers working on the same 
corridor.

b) The Corridor Name itself (not the dgn file name) should match the name of the baseline 
Horizontal Alignment (Ex. SR100).  If multiple Corridors are needed for a single baseline 
Horizontal Alignment, and they reside in the same DGN file, the Name is automatically 
appended with a consecutive # (Ex. SR1001), so some editing/renaming of the Corridor 
Names may be needed by the Designer.  Note: If the Corridor Name is blank, it will present 
problems later on when creating an Earthwork Volume Report.

c) Superelevation in ORD is created by using the Create>Superelevation Sections/Lanes 
command, using the latest AASHTO standards xml file, currently AASHTO 2018 imperial.

d) If an end condition fails to solve because there is no Existing Terrain (an obscured area) to 
intersect, the Designer is instructed to contact the Office of Design Policy and 
Support/Location Bureau to request additional Terrain Coverage in that area.

e) In order to place a temporary Template so that the Station at the obscured area can close, 
Target Aliasing is utilized. Target Aliasing consists of creating a Bogus Terrain in order to cut 
a Cross Section to form a closed area.  Additional Survey shall be requested to provide a 
correct Terrain.

f) The Naming Convention for the temporary Bogus Terrain used in Target Aliasing is 
PI#Bogus1 (Ex. 1234567Bogus1).

g) Do not place more than around 10 Civil Cells in a single Corridor .dgn file; otherwise, the 
processing time could be negatively impacted.
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6.2 Corridor Creation Workflow

The Corridor Creation process consists of the following steps (Note: after Step 1, the Steps do not need to be 
performed in any particular order; in fact, not all Steps are necessary on every project):

Step 1: Create a New Corridor – The Corridor (or Corridors, if needed) is created for a specific baseline 
horizontal alignment and associated vertical alignment.  During the initial Corridor Creation process, a Template 
will be dropped along the Corridor for a specified Station Range at a user-defined Interval.  This Template may 
be edited later, and additional Templates may also be dropped as well, if needed.  There are 6 Feature 
Definitions that define how the Corridor is displayed, which can be changed at any time:

• Conceptual: Will drop Templates at 5X the Interval (i.e. If Interval is 5’, the 
drops will occur every 25’ instead).  This Feature Definition has the quickest 
processing time.

• Design: Will drop Templates at 2X the Interval (i.e. If Interval is 5’, the drops 
will occur every 10’ instead).

• Final: Will drop Templates at 1X the Interval (i.e. If Interval is 5’, the drops 
will occur every 5’ instead).

• Final Bottom Mesh: As Final but used only for creating a final surface XML 
deliverable.  

• Final Top Mesh: As Final but used only for creating a final surface XML 
deliverable.  

• Final w/Contours: Will drop Templates at 1X the Interval (i.e. If Interval is 5’, 
the drops will occur every 5’ instead) and will also display Contours.

Step 2: Add Template Drops – Once created, Design will add any additional needed Template Drops to specified 
station ranges in the Corridor/s.

Step 3: Add Key Stations – Add any special Key Stations where a Template Drop is desired, such as a Driveway 
baseline.

Step 4: Add Corridor References – Graphical elements used to target for Corridor processing.  Example: Using an 
intersection matchline with a side road as a Corridor Reference to target in order to turn off the shoulder, curb, 
sidewalk and end condition at this precise Station Range.

Step 5: Add Parametric Constraints – Many Templates have Parametric Constraint Labels already assigned, such 
as Gutter Width/Height/Slope, Ditch Width, End Condition Slopes, etc.  Use Parametric Constraints to vary 
Template Point Constraints over a specified Station Range, when needed. Important: ORD has a known bug 
whereby any parametric constraint labels on components placed on the left side of a template will automatically 
prepend a minus sign (“-“) to the label name. Unfortunately, the bug is that any parametric constraint label with 
this minus sign will not appear in the Corridor Objects window as a selectable Constraint Label. This has been 
filed as a defect, but unless and until it is fixed, users may need to manually remove this minus sign and instead 
add a “_L” or “_R” (for left/right side) onto any labels to ensure they are usable.
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Step 6: Add Secondary Alignment – Secondary Alignments change the processing of the Templates to be 
perpendicular to the Secondary Alignment instead of the original baseline of the Horizontal Alignment.  Useful 
for tapers/turn lanes, ramps, etc.

Step 7: Add Control/Target Alignments – Create geometry in a PI#CTRL.dgn file for use in conjunction with Point 
Controls, to help refine how a particular template is constructed over a station range. The PI#CTRL.dgn file is not 
plotted, but rather used as a reference file to control the corridor in the PI#CORD.dgn file, if needed. For this 
reason, the PI#CTRL.dgn file is not included in the level setting buttons located in the GDOT PDF Plotting ORD 
workflow.

Step 8: Add Point Controls – Point Controls are used in cross section design to override a point’s usual Template 
constraint. Example uses of Point Controls in a cross section design would be to have the point representing the 
outside edge of a travel lane instead follow a horizontal alignment to widen for an auxiliary lane (such as a turn 
lane) or having a point follow a different vertical alignment for split grades.

Step 9: Add Corridor Clipping Reference – Used to remove a portion of an intersecting Corridor, useful in certain 
design situations like a Bridge.

Step 10: Define Target Aliasing – Used on End Conditions to seek/target Terrains, Corridors or other Features. 

Step 11: Add End Condition Exceptions – End Condition Exceptions are applied to End Conditions during cross 
section design when the normal behavior of an End Condition is not sufficient for actual conditions and it is not 
desirable to create and place new templates. Examples include steepening slopes to stay inside Right-of- Way 
and additional shoulder widening for guardrail anchorage.

Step 12: Add Superelevation – Superelevation Control Lines are added to control the Roadway cross slope in 
horizontal curve areas. ORD utilizes Superelevation Tables based on the AASHTO 2018 Green Book. 
Superelevation for each alignment should be in its own file, e.g. PI#SUPR_Alignment Name.dgn.

Step 13: Add Annotation – Annotate elements, such as adding Ditch Flow Arrows, by using the command 
Element Annotation>Annotate Element, and then selecting the elements you want annotated.
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6.3 Corridor Naming Conventions

The DGN file/s should be named PI#CORD#A_RoadName.DGN (Ex. 1234567CORD1B_SR92.DGN). Keep the file 
names as concise as possible by only using the applicable SR/CR/US/CS number, as shown above.  For roads that 
do not have a route designation or when it is unknown, again, be as concise as possible (for example, instead of 
1234567CORD3_Bell Bottoms Lane.dgn, truncate to 1234567CORD3_BBLN.dgn).  The # and Letter that comes 
after CORD in the file name is unique to that corridor.  Each corridor must have its own unique # and only if 
there are multiple corridor files desired due to its length (> 1 mile), will it require an alphanumeric designation 
(i.e. for a 2-mile project on SR 92, it may require 2 corridor files, named 1234567CORD1A_SR92.dgn and 
1234567CORD1B_SR92.dgn).  Multiple DGN files for a long project consisting of multiple corridors are not 
required, but it may help facilitate in file-sharing amongst multiple designers working on the same project.  (See 
Table 6.1).

Table 6.1
Standard Corridor File Names

Single Corridor File Name (< 1 mile in length) Example

PI#CORD#_RoadName.DGN 1234567CORD1_SR92.DGN

Multiple Corridor File Names (> 1 mile in length) Example

PI#CORD#A_RoadName.DGN
PI#CORD#B_RoadName.DGN
PI#CORD#C_RoadName.DGN
etc.

1234567CORD1A_SR92.DGN
1234567CORD1B_SR92.DGN
1234567CORD1C_SR92.DGN

etc.

A Corridor is a strip of land defined by a horizontal and vertical alignment or alignments. It can be considered the 
project’s footprint. Cross section design is performed in the Corridor and the Final Surface is created from the 
corridor. The Corridor Name should match the corresponding Alignment’s Name as closely as possible. (See 
Table 6.2).

Table 6.2 Standard Corridor Name (Roadway or Alignment Name)

Roadway or Alignment Name Example:  SR100
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6.4 Bogus Terrain Naming Conventions for Target Aliasing

When a Template’s End Condition encounters an obscured area or extends beyond the available Existing 
Terrain, the End Condition fails to solve and is not placed. ORD does not extend the existing ground in order to 
finish the placement of the Template. When these situations are encountered, the Designer is instructed to 
request additional Terrain coverage from the Office of Design Policy and Support/Location Bureau. The 
Location Bureau will provide a new Existing Terrain (TOPO.DGN file) to the Designer with the additional 
coverage.  Until Location provides the updated terrain, the designer may get a temporary estimate of the end 
condition extents by using a ‘Bogus Terrain’.  Target Aliasing may then be used with the ‘Bogus Terrain’.

The creation of a Bogus Terrain is necessary in ORD if there are obscured areas in which cross-sections cannot 
form a closed area for earthwork calculations. These cross sections shown on the cross section sheets are 
generated from the Final Proposed Terrain and Bogus Terrain. The Naming Convention for the Bogus Terrain 
used in Target Aliasing is PI#BogusTerrain.DGN (Ex. 1234567BogusTerrain.DGN).  (See Table 6.3).

Table 6.3
Standard Bogus Surface for Target Aliasing

PI#BogusTerrain.DGN Example:  1234567BogusTerrain.DGN
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 Cross Section Sheets/Annotation Generation
This section provides an overview of the requirements for generating Cross Section Sheets and Updating 
Annotation after Design changes. For generic training on this process, please go through the Bentley Learning 
path Drawing Production – Creating Cross Section Sheets: 
https://learning.bentley.com/learn/courses/676/drawing-production-creating-cross-section-sheets/lessons 

7.1 Cross Section Sheets/Annotation Overview

The following section depicts an overview of the processes to create Cross Section Sheets to GDOT standards in 
ORD. In order to generate Cross Sections, the following information must be followed:

a) In order to generate cross sections, an Existing and Finished Terrain must first exist (and 
therefore, Horizontal/Vertical Alignments, Corridor, etc.). The cross sections are then 
cut from the Finished Terrain.

b) The Place Named BoundaryCivil Cross Section command is used to create the Cross 
Sections, which are saved as Models within the PI#_23.DGN file.  There are three custom 
Drawing Seed options provided to define the Scale, L/R Offsets, and other parameters.  
See Section 7.2 for descriptions of the various Drawing Seeds used by GDOT.

c) The Cross Section “Cut Sheets” use cells for the grids and border instead of 
DGN Reference Files.

d) The Annotation of Cross Sections is done automatically.  See Section 7.3 for how 
to Update Annotation when changes are made to the Design.

https://learning.bentley.com/learn/courses/676/drawing-production-creating-cross-section-sheets/lessons
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7.2 Cross Section Sheet Drawing Seed Preferences

The generation of Cross Section Sheets is accomplished by using the Place Named BoundaryCivil Cross 
Section command. This command uses Drawing Seed Preferences which have been set up in order to create the 
Cross Section Sheets to GDOT Standards. In order to generate/view Cross Sections to GDOT Standards, the 
desired Drawing Seed must be set. The Drawing Seed options are described below. (See Table 7.1).

Table 7.1

Cross Section Drawing Seeds
Location: Place Named Boundary  Civil Cross Section

Drawing Seed Description

XS - Narrow 20h 20v

Used for Plans Production of Cross Section “Narrow” Sheet generation. This 
Preference loads the settings into the Place Named Boundary dialog to view Cross 
Sections in a Narrow format on the GDOT SUXSEN Cross Section plan sheet cell. 
The Preference loads settings for a 1”=20’ Scale Horizontally and Vertically.

XS - Wide 20h 20v

Used for Plans Production of Cross Section “Wide” Sheet generation.  This 
Preference loads the settings into the Cross Sections dialog to view Cross Sections 
in a Wide format on the GDOT SUXSEW Cross Section plan sheet cell. The 
Preference loads settings for a 1”=20’ Scale Horizontally and Vertically.

XS - Wide 40h 40v

Used for Plans Production of Cross Section “Extra Wide” Sheet generation. This 
Preference loads the settings into the Place Named Boundary dialog to view Cross 
Sections in a Wide format on the GDOT SUXSEW Cross Section plan sheet cell. The 
Preference loads settings for a 1”=40’ Scale Horizontally and Vertically. This allows 
for cross sections with offsets up to 300’ L/R.

7.3 Cross Section Sheet Annotation Updates

The typical annotation of Cross Section Sheets is done automatically.  This includes annotation text for slopes, 
station/offset, elevations, L/R offsets, ditch elevations, etc. However, if any changes are made to the Corridor 
Design (i.e. altering the Horizontal/Vertical Alignment, adding a turn lane, changing the Superelevation, etc.), the 
Cross Section Sheet Annotation will need to be redone.  This is easily accomplished in ORD by using the Drawing 
Production  Annotations  Drawing Model Annotation  Remove Drawing Model Annotations command.  
Unless you are only impacting a small area that is known, it is typically better to choose All Drawing Models, 
when prompted.  After removal, simply reannotate them by selecting the Drawing Production  Annotations 
 Drawing Model Annotation  Annotate Drawing Model command, again selecting All Drawing Models, 
when prompted (unless the impact is localized and known, in which case you may select the specific Sheet 
Models to update).  Note: Be sure to choose the correct Annotation Group when annotating.
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  Earthwork
This section provides a brief overview of the requirements and processes for generating Earthwork Quantities 
and Earthwork Volume Reports. For generic training on how to generate Earthwork information please see the 
Bentley Learning path Quantities and Earthwork: https://learning.bentley.com/learn/courses/677/quantities-
and-earthwork/lessons

8.1 Earthwork Overview

The following section depicts an overview of the processes to generate Earthwork Quantities and Earthwork 
Volume Reports to GDOT Standards in ORD. In order to generate these Quantities and Volume Reports, the 
following information shall be adhered to:

a) In order to generate Earthwork Quantities and Volume Reports, a Corridor must first be 
created.

b) Place a Named Boundary Civil Cross Section using a standard Drawing Seed (see below for 
Drawing Seed descriptions).

c) To see End Area Volumes Report, click on Home>Civil Analysis> End Area Volumes Report.  
Select the Style Sheet named EndAreaVolume.xsl in the Bentley Civil Report Browser.

d) Make sure that each Cross Section at each applicable Station forms a closed area. If the 
areas do not close, the volume calculations will be inaccurate. This is especially the case if 
there are obscured areas. The Designer is reminded to contact the Office of Design Policy 
and Support/Location Bureau for any additional survey required in the obscured areas. If 
these areas are not resolved – inaccurate volume calculations will result.

https://learning.bentley.com/learn/courses/677/quantities-and-earthwork/lessons
https://learning.bentley.com/learn/courses/677/quantities-and-earthwork/lessons
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8.2 Cross Section Drawing Seeds

The generation of Cross Section Sheets is accomplished by using the Place Named Boundary command in ORD. 
This command contains Preferences which have been set up in order to create the cut Cross Section Sheets to 
GDOT Standards. In order to generate/view Cross Sections to GDOT Standards for Earthwork Volumes, Drawing 
Seed Preferences must be set. Drawing Seed Preferences set the viewing/creation of Cross Sections when using 
the OpenRoads Modeling  Drawing Production  Named Boundary  Place Named Boundary Civil Cross Section 
command. (See Table 8.1).

Table 8.1

Drawing Seeds – Named Boundary Civil Cross Section

Location: OpenRoads Modeling Drawing Production Named Boundary Place Named Boundary

Drawing Seed Name Description

XS - Narrow 20h 20v
(Use for Plans Production)

Used for Plans Production of Cross Section “Narrow” Sheets and/or Earthwork 
Volumes generation. This Preference loads the settings into the Place Named 
Boundary Civil Cross Section dialog to view Cross Sections in a Narrow format on 
the GDOT SUXSEN Cross Section plan sheet cell. The Preference loads settings for a 
1”=20’ Scale Horizontally and Vertically.

XS -  Wide 20h 20v
(Use for Plans Production)

Used for Plans Production of Cross Section “Wide” Sheet and/or Earthwork 
Volumes generation. This Preference loads the settings into the Place Named 
Boundary Civil Cross Section dialog to view Cross Sections in a Wide format on 
the GDOT SUXSEW Cross Section plan sheet cell. The Preference loads settings 
for a 1”=20’ Scale Horizontally and Vertically.

XS -  Wide 40h 40v
(Use for Plans Production)

Used for Plans Production of Cross Section “Wide” Sheet and/or Earthwork 
Volumes generation. This Preference loads the settings into the Place Named 
Boundary Civil Cross Section dialog to view Cross Sections in a Wide format on 
the GDOT SUXSEW Cross Section plan sheet cell. The Preference loads settings 
for a 1”=40’ Scale Horizontally and Vertically.
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8.3 GDOT Earthwork Volume Report

The generation of the Earthwork Volume Report may be accomplished by using the generic Bentley Style Sheet 
EndAreaVolume.xsl Style Sheet. This Style Sheet is accessed by selecting the following command: OpenRoads 
Modeling  Home  Civil Analysis  End Area Volumes Report. Click the EndAreaVolume.xsl Style Sheet after 
the Bentley Civil Report Browser opens. The Style Sheet can be saved as an HTML file. 
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  Required Right of Way
This section provides a brief overview of the requirements and processes for storing R/W Parcels and generating 
Right of Way Tables to GDOT Standards.

9.1 Right of Way Overview

The following section depicts an overview of the processes to generate Required R/W and Easement Alignments, 
R/W DGN Files and R/W and Easement Tables to GDOT Standards. Failure by the Designer to follow the correct 
Point and Alignment naming convention may cause problems with Survey Enhancements during the life of the 
project and with Stakeout Report generation. In order to generate these Required R/W and Easements, the 
following information shall be adhered to:

a) Required Right of Way and Easement Alignments and Points must be stored in 2 separate 
models within the PI#REQD.dgn file:
• a RWParcelGeom model for creating the non-plotting closed shapes necessary to 

create the Right of Way Tables and .out files for Deed generation
• a REQD model to display all the necessary Right of Way/Easement alignments that 

need to be plotted

b) Follow the Required Right of Way and Easement Alignment workflows detailed in the 
GDOT ORD Design Workflow Processes document on ROADS.

http://www.dot.ga.gov/PartnerSmart/DesignSoftware/OpenRoads/ORD%20Design%20Workflow%20Processes.pdf
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9.2 R/W Alignment and Point Names/Feature Definitions

The Right of Way Horizontal Alignments and Points must be stored with a DE Prefix, with a unique number 
identifier (i.e. DE50, DE 61, etc.)  and must be assigned the appropriate Feature Definition. See Table 9.1 for a list 
of Feature Definitions.

Table 9.1
Feature Definitions For R/W Design Points and Alignments

Proposed Design Point 
Feature Definitions

REQD_P_DWESMT 
REQD_P_PESMT
REQD_P_REQD
REQD_P_RWRM REQD_P_TESMT

Proposed Right of Way 
Description

Feature Definition Feature Name Example

R/W Monument REQD_P_RWRM DE35

Reqd. R/W REQD_P_REQD DE35

Perm. Const. Esmt. REQD_P_PESMT DE35

Temp. Const. Esmt. REQD_P_TESMT DE35

Driveway Esmt. REQD_P_DWESMT** DE35

** Note: All other Types of Miscellaneous Easements should use the REQD_P_DWESMT Feature Definition.
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9.3 R/W and Easement Tables (Style Sheets)

The generation of the R/W and Easement Tables is accomplished in the OpenRoads Modeling workflow with the 
command: Geometry  General Tools  Reports  Legal Report.  In the Bentley Civil Report Browser select 
the GDOT RW Table_ORD.xsl Style Sheet (or for Railroad easements, the GDOT RailRoad RW Table_ORD.xsl 
Style Sheet).  The Report can be saved as a .txt file and then imported into ORD as a table. For additional 
information regarding the Style Sheet, review the Style Sheet Help File which is included with the 
GDOT_Org_Civil_Standards_CaddAll.exe standard files (external users) or on ProjectWise (internal users).  See 
Table 9.2).

Table 9.2

Style Sheet Report (Table) – GDOT RW Table_ORD.xsl & GDOT RailRoad RW Table_ORD.xsl
OpenRoads Modeling ► Geometry ► General Tools ► Reports ► Legal Report

Style Sheet Name Description

GDOT RW Table_ORD.xsl The GDOT RW Table_ORD.xsl Style Sheet is utilized to create Right-of-Way Table 
text files for placement in OpenRoads Designer with File Import  Text 
command.

Please Refer to the GDOT RW Table_ORD.xsl Style Sheet Help File for 
additional information.

GDOT RailRoad RW Table_ORD.xsl The GDOT RailRoad RW Table_ORD.xsl Style Sheet is utilized to create Railroad 
Right-of- Way Table text files for placement in OpenRoads Designer with File 
Import  Text command.

Please Refer to the GDOT RailRoad RW Table_ORD.xsl Style Sheet Help File for 
additional information.



ORD Design Guidelines

9. Required Right of Way

Page 77

9.4 R/W Deed (Style Sheets)

The generation of the Right of Way Deed is accomplished in the OpenRoads Modeling workflow with the 
command: Geometry  General Tools  Reports  Legal Report.  In the Bentley Civil Report Browser select 
the GDOT Deed_ORD.xsl Style Sheet.  The Style Sheet MUST BE saved as a .out file. This .out file is then used in 
the stand-alone Deed Writer Program to generate GDOT Deeds for purchase of Right of Way. For additional 
information regarding the Style Sheet, review the Style Sheet Help File which is included with the 
GDOT_Org_Civil_Standards_CaddAll.exe standard files (external users) or on ProjectWise (internal users). (See 
Table 9.3).

Table 9.3

Style Sheet Report (Table) – GDOT Deed_ORD.xsl

OpenRoads Modeling ► Geometry ► General Tools ► Reports ► Legal Report

Style Sheet Name Description

GDOT Deed_ORD.xsl The GDOT Deed_ORD.xsl Style Sheet is utilized to supply a Deed.out file to the 
Right-of- Way office. The Right-of-Way office utilizes the Deed.out file to 
generate a Deed.

Please Refer to the GDOT Deed_ORD.xsl Style Sheet Help File for additional 
information.

Please Note: The Style Sheet must be saved as a .out file for use with the 
GDOT Deed Writer Program.
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 Survey Enhancements
This section provides a brief overview of the processes to include Additional Survey Enhancements received 
from Photogrammetry/Survey during the Design Phase of a project. 

10.1 Survey Enhancements Overview

The following section depicts an overview of the processes to incorporate Survey Enhancements during the 
Design Phase of a project according to GDOT Standards. In order to add the Survey Enhancement Data, the 
following information shall be adhered to:

a) During the life of a Design project, additional Survey Enhancements may need to be 
incorporated into the project and the new survey data re-submitted to the Designer in 
order for the Designer to update the design database.

b) All location survey data and all requests for additional survey/property data should be 
submitted to the Office of Design Policy and Support/Location Bureau.

c) Depending on what type of enhancements are collected, the SDE will process the additional 
survey data and send the Designer the appropriate files as required. This could result in 
the SDE sending the Designer all of the updated files or just certain files depending on what 
data was collected.

d) The Designer will receive a new PI#TOPO.dgn and/or a new PI#UTLE.dgn from the SDE 
when Enhancements are requested and incorporated for Existing Terrain/Property/Utility 
Data. These files supersede the old files and the Designer will need to use the new files 
instead. In ProjectWise, this is as simple as dropping it into the same Project Folder, which 
will create a new version of the .dgn file and automatically update any .dgn files using it as 
a reference.

e) A new Enhanced TOPO file may not always be provided to the Designer if no changes were 
made to the property or survey data by the SDE. The SDE will only provide an Enhanced 
PI#TOPO.dgn file if new Features have been surveyed and incorporated into the 
PI#TOPO.dgn file.

f) A new Enhanced UTLE file may not always be provided to the Designer if no changes were 
made to the Utility Features by the SDE. The SDE will only provide an Enhanced 
PI#UTLE.dgn file to the Designer if new data has been surveyed and incorporated into the 
PI#UTLE.dgn file.

g) The PI#TOPO.dgn file received from the SDE contains all of the Terrain Points, Breaklines, 
Features, along with the triangulated data.  It also contains the Property/Existing 
Alignment information, including the SV Prefix Alignments and the Survey Points.

h) In most cases the following files (or a combination) of these files will be submitted to the 
Designer for use as Additional Survey Enhancements:
• PI#TOPO. dgn (if applicable)
• PI#UTLE.dgn (if applicable).
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Additional Survey Enhancement Process
(Red Dotted Line represents Additional Survey Enhancement Process Overview)
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10.2 Survey Enhancements to the DGN files

The following section depicts information regarding the DGN file(s) submitted to the Designer whenever Survey 
Enhancements have been incorporated by the SDE. The following DGN File(s) are updated (if applicable) by the 
SDE after merging the new data into the original PI#SURV.dgn file: PI#UTLE.dgn and PI#TOPO.dgn files.  The 
PI#SURV.dgn is for SDE use only and is used to create the PI#TOPO.dgn and/or PI#UTLE.dgn files for Design. The 
Designer may not always receive both of the aforementioned files. The Designer will only receive the updated 
DGN files if changes were made to the DGN files by the SDE.

If Enhanced DGN Files are provided by the SDE, these shall supersede those files used previously by the 
Designer.  It is best to keep versioned copies, rather than simply deleting/overwriting the previous files.  This can 
easily be accomplished in ProjectWise by simply dragging the files into the correct Project Folder and selecting 
to create a new version of the existing file.
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 ORD Style Sheets
This section provides a brief overview of the requirements and processes for generating Reports/ Style Sheets to 
GDOT Standards. For additional information regarding the processing of Style Sheets, please refer to the more 
detailed documentation provided for each Style Sheet.

11.1 ORD Style Sheets Overview

Style Sheets are used by ORD to present data in a particular Report Format. The Style Sheets are XSL files which 
can be saved in different extensions depending on the Style Sheet used.

Formats can be saved as .HTML, .OUT, .TXT, etc. depending on the function of the Style Sheet. GDOT has several 
Style Sheets which can be used to generate Report Data in a format for use in submitting Report deliverables for 
Design, Survey, Construction, etc. In order to generate these Style Sheets to GDOT Standards, the following 
information shall be adhered to:

a) The Style Sheet Data is based on XML (Extensible Markup Language) code which is used 
to generate the data from ORD into an XSL (Extensible Style Sheet Language) Report 
Format.

b) In order to generate Style Sheets to GDOT Standards for deliverables, use the Style 
Sheets in the GDOT folder in the Bentley Civil Report Browser.

c) It is very important that only the Style Sheets that have the name GDOT in it are used 
for submitting deliverables according to GDOT Standards. Designers may use generic 
ORD Style Sheets during the Design Process, but all deliverable Reports MUST use the 
GDOT Style Sheets according to Design Policy.
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11.2 Location of GDOT Style Sheets

As mentioned previously, in order to generate Reports to GDOT Standards for deliverables, the GDOT Standard 
Style Sheets shall be utilized. The GDOT Style Sheets are included in the 
GDOT_Org_Civil_Standards_CaddAll.exe download executable file.  They can be accessed, both internally and 
externally, by navigating to the GDOT folder in the Bentley Civil Report Browser.

11.3 Location of GDOT Style Sheet Help Files

GDOT Style Sheet Help Files are available for internal GDOT users in ProjectWise here: Style Sheets

For external users, these are included in the GDOT_Org_Civil_Standards_CaddAll.exe download executable file.  
Once GDOT_Org_Civil_Standards_CaddAll.exe is executed and installed, the GDOT Style Sheets will be installed 
and located in the following path (Drive Letter is C: by default, but is variable):

\GDOT_CE\Organization-Civil\GDOT_Org_Civil_Standards\Reports\GDOT\Style Sheet Help Files\

These GDOT Style Sheet Help Files depict detailed information regarding the usage of the Style Sheets, the 
format of the Style Sheets and the type of extension (.html, .txt, .etc.) in which the Style Sheet should be saved.

pw://gdot-go-pwis01.gdot.ad.local:ProjectWise/Documents/P%7b536f565a-81da-4b79-afa8-9dab929e503b%7d/
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11.4 Descriptions of GDOT Style Sheets

Customized Style Sheets have been created to GDOT Standards in order to provide Reports for ORD Data. These Style Sheets correspond to GDOT Policy 
and shall be utilized for Report deliverables when required. The following Table lists the current available GDOT Style Sheets, the Location to Access the 
Style Sheets in ORD and a brief Description of the Style Sheets. Detailed Help Files are also available as discussed in Section 11.3.

Table 11.1
Style Sheet Descriptions

Style Sheet Name (.xsl)
Location of 
Command Description

GDOT 3D Alignment 
Comparison Report_ORD

OpenRoads Modeling 
Geometry  General 
ToolsReports  Station 
Base Report

Reports the Station, Elevation, Horizontal Offset and Vertical Offset from one 
alignment (Baseline Alignment) to a second alignment (Offset Alignment).

GDOT Alignment File 
Descriptions_ORD

OpenRoads Modeling 
Geometry  General 
ToolsReports  
Horizontal Geometry 
Report

Reports a text file description of the baseline alignments to the Contractor.

GDOT Alignment 
Report_ORD

OpenRoads Modeling 
Geometry  General 
ToolsReports  
Horizontal Geometry 
Report

Reports Horizontal Alignment information to the Contractor for use in GPS 
equipment. The Report depicts the Alignment information located at 50 
Foot Station intervals at a Zero Offset.  The Alignments may all be generated 
at one time and listed in a single Report.

GDOT Deed_ORD OpenRoads Modeling 
Geometry  General 
ToolsReports  Legal 
Report

Utilized to supply a Deed.out file to the Right-of-Way office. The Right-of-
Way office uses the Deed.out file to generate a Deed using the DeedWriter 
program.
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Style Sheet Name (.xsl)
Location of 
Command Description

GDOT Feature- 
StationElevationOffset 
Report_ORD

OpenRoads Modeling 
Geometry  General 
ToolsReports  Station 
Offset Report

Creates a Station, Elevation and Offset Report from the Roadway Baseline 
to selected Features in the Terrain model.

GDOT HEC RAS Bridge 
Features Report_ORD

OpenRoads Modeling 
Geometry  General 
ToolsReports  Station 
Offset Report

Creates a Station, Elevation and Offset Report from the Roadway Baseline 
to selected Terrain Features representing the existing Bridge Geometry. 
This Report is then used for input of the Bridge Geometry data into HEC 
RAS.

GDOT HEC RAS Cross
Section Geometry 
Report_ORD

OpenRoads Modeling 
Geometry  General 
ToolsReports  Profile 
Report

Creates a comma-delimited Station and Elevation Report from the 
Roadway Baseline for use in importing Cross Sectional geometric data 
into HEC RAS. The cross-sectional data is reported based on the Offset 
Parallel Alignments/Profiles from the Roadway Baseline through a Stream 
Center.

GDOT Parcel Check 
Report_ORD

OpenRoads Modeling 
Geometry  General 
ToolsReports  
Horizontal Geometry Report

Utilized during quality assurance checks on existing property in the 
TOPO.DGN file. The report identifies parcels that have not been stored 
clockwise and parcels that are not closed.

GDOT Ponding 
Report_ORD

OpenRoads Modeling 
Home  Model Analysis 
and Reporting Reports  
Station Base Report

Reports profile stations where the longitudinal grade < 1.0% and the road 
cross slope < 0.5%.

GDOT RailRoad RW 
Table_ORD

OpenRoads Modeling 
Geometry  General 
ToolsReports  Legal 
Report

Creates Railroad-specific Right-of-Way Table text files for placement in 
ORD with File Import  Text command.
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Style Sheet Name (.xsl) Location of Command Description

GDOT RW Table_ORD OpenRoads Modeling 
Geometry  General 
ToolsReports  Legal Report

Creates Right-of-Way Table text files for placement in ORD with File 
Import  Text command.

GDOT Station-Offset 
Report_ORD

OpenRoads Modeling 
Geometry  General 
ToolsReports  Point Feature 
Station Offset Elevation Report

Supplies Station and Offset information of selected Points to a selected 
Horizontal alignment.

GDOT SUE Utility QL-A 
Location Report_ORD

OpenRoads Modeling 
Geometry  General 
ToolsReports  Point Feature 
Station Offset Elevation Report

The GDOT SUE Utility QL-A Location Report_ORD.xsl Style Sheet is 
utilized to supply a report depicting Test Hole Name, Description, Station 
and Offsets for SUE QL-A Test Hole data.

GDOT Superelevation 
Data
Report_ORD

OpenRoads Modeling 
Geometry  General 
ToolsReports  
Superelevation Report

The GDOT Superelevation Data Report_ORD.xsl Style Sheet is utilized to 
provide superelevation information that was applied using the Create 
Superelevation Wizard. The GDOT Superelevation Data Report lists the 
Station, Cross Slope and Point Type (Normal Crown, Zero Cross Slope, 
Reverse Crown, and Full Super) for each superelevation transition location.

GDOT Surface Check 
Report-MPCKGRD_ORD

OpenRoads Modeling Terrain 
 AnalysisPoints  Analyze 
Elevation

The GDOT Surface Check Report-MPCKGRD_ORD.xsl Style Sheet is 
utilized to verify the tolerance and accuracy of an Existing Digital Terrain 
Model (original terrain surface) as compared against associated field 
survey points along the ground.

GDOT Surface 
Check Report-
MPCKPAV_ORD

OpenRoads Modeling 
Terrain  AnalysisPoints 
 Analyze Elevation

The GDOT Surface Check Report-MPCKPAV_ORD.xsl Style Sheet is utilized 
to verify the tolerance and accuracy of an Existing Digital Terrain Model 
(original terrain surface) as compared against associated field survey points 
along the pavement.
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 Additional File Deliverables
Note: A new document outlining the ORD Workflows for 3D Construction Deliverables is available at this link. 
This deliverable is mandatory for non-legacy software projects beginning with the March 2026 letting, which 
corresponds to final plans submitted to the Office of Bidding Administration in January 2026. This new workflow 
supersedes the current requirements specified in Section 12.3 “ORD File Deliverables for Contractors”.

This section provides a brief overview of Additional File Deliverables which are required to be submitted when 
using ORD. Several Additional Files are generated in ORD for use by other Offices internal to GDOT. Additional 
Files are also provided to Contractors when a Project is complete and let to Construction.

This section covers the following topics:

• Additional File Deliverables Overview

• ORD File Deliverables to GDOT
o Write Stakeout Data to a Data Collector
o Generate GDOT Deed File(s)
o ORD Project Data Sheet(s)
o GDOT ORD Design Data Quality Assurance Checklist
o Assembly of ModelReview.dgn

• ORD File Deliverables to Contractors
o Alignment File Description(s)
o Alignment Report File(s)
o 3D Model Files

12.1 Additional File Deliverables Overview

The following section depicts an overview of the Style Sheets, Data Files and Reports which are required as 
Additional File Deliverables. In order to generate these Additional File Deliverables, the following information 
shall be adhered to:

a) The GDOT Standard Style Sheets for generating Additional File Deliverables are included 
in the GDOT_Org_Civil_Standards_CaddAll.exe download for external use.  Internally, 
these are stored in ProjectWise and can be accessed by navigating to the GDOT folder 
in the Bentley Civil Report Browser.  To set the GDOT folder as the default folder in the 
Bentley Civil Report Browser, click on Tools>Style Sheet Root, highlight the GDOT folder 
and click OK.

b) For Detailed Help Instructions on using the Style Sheets, please see the GDOT Style 
Sheet Help Files, included in the GDOT_Org_Civil_Standards_CaddAll.exe download for 
external use.  Internally, the Help documentation can be found in ProjectWise here: 
Style Sheets.

c) To generate the GDOT Stakeout Data File for staking of R/W, see Section 12.2.1 
below.

https://www.dot.ga.gov/PartnerSmart/DesignSoftware/OpenRoads/ORD%20Workflows%20for%203D%20Construction%20Deliverables.pdf
pw://gdot-go-pwis01.gdot.ad.local:ProjectWise/Documents/P%7b536f565a-81da-4b79-afa8-9dab929e503b%7d/
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d) To generate the Deed output files for use in writing Deeds, the following Style Sheet 
should be used:  GDOT Deed_ORD.xsl.

e) To generate the Alignment File Descriptions which depict the Alignment 
information (including the Curve Data and Coordinate information), the following 
Style Sheet should be used: GDOT Alignment File Descriptions_ORD.xsl.

f) To generate the Alignment Report files which depict the Alignment 
information at 50’ intervals for use by Contractors, the following Style Sheet 
should be used: GDOT Alignment Report_ORD.xsl.

g) The Project Data Sheet is a required Deliverable that should list all of the pertinent 
ORD Design information. This file is used by Designers to help document associated 
files and data for use during the Design process. This file is also submitted as a 
deliverable with the ORD project files so that users who inherit the project can easily 
identify project data. This File is available on the ROADS webpage here.

h) A Quality Assurance Control Checklist is also required. This is a checklist that the 
Designer should utilize to ensure that all pertinent Design Data is included for Project 
Delivery. This File is available on the ROADS webpage here.

12.2 ORD File Deliverables to GDOT

As mentioned previously, there are several Additional File Deliverables which are required to be submitted by 
the Designer for use by other Offices in the Department. The following Section contains information on how to 
generate the following Report/Data Files:

• Write Stakeout Data to a Data Collector using ORD LandXML
• Generate GDOT Deed File(s)
• ORD Project Data Sheet(s)
• GDOT ORD Design Data Quality Assurance Checklist
• Assembly of ModelReview.dgn

12.2.1 Write Stakeout Data to a Data Collector as LandXML

The following procedure is used to export Stakeout Data such as COGO Points, Horizontal/Vertical Alignments, 
etc. from ORD to a LandXML file.  This must be done in 2 parts: one for the Survey Features, and another for the 
Geometry Alignments/Points.  The resulting 2 LandXML files can then be uploaded to the GDOT Trimble Business 
Center/GDOT Trimble Data Collectors for use in staking out Survey Data.

12.2.1.1 Workflow Procedure for Survey Features:

A. Open the PI#TOPO.dgn file in ORD.

B. View Required Survey Features for Stakeout Data

1. Deselect ALL Point Features and ALL Linear Features in the Field Book so that nothing is 
viewing on screen.

http://www.dot.ga.gov/PS/DesignSoftware/OpenRoads
http://www.dot.ga.gov/PartnerSmart/DesignSoftware/OpenRoads/Design_Data_ORD_QA.pdf
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2. Select the Stakeout Data Point Features Survey Filter so that all required features are 
viewed on screen. See Table 12.1 below for list of Feature Definitions in the Survey Filter.

3. Select All features viewed.

C. Create the LandXML File

1. In the Survey Workflow, select Field Book Export LandXML

2. Accept the defaults by left-clicking.

3. Save the file as PI#SURV.xml

Table 12.1: Survey Point Feature Definitions to Export to LandXML

PROP_E_RWC PROP_E_RWM PROP_E_PPC PROP_E_PCF
TOPO_E_SBNCHMK TOPO_E_SDCD TOPO_E_SLCD TOPO_E_SLCM
TOPO_E_SNGSCM

12.2.1.2 Workflow Procedure for Design Features:

A. Open your main geometry file (PI#GEOM.dgn) in ORD, with all levels turned on.

B. Ensure that the following files are referenced, and all levels are on (at least temporarily for this 
workflow):

1. All other geometry files (if more than 1 exists)

2. PI#TOPO.dgn

3. The model RWParcelGeom within the PI#REQD.dgn file.

C. In OpenRoads Modeling workflow, select Geometry>General Tools>Design Elements>Select 
by Graphical Filter.

1. Select the Stakeout Data Graphical Filter Group and data point to accept.  This should 
select all of the features needed to export, whether referenced or existing in the 
opened file.  See Table 12.2 below for list of Feature Definitions included in this 
Graphical Filter Group.

2. Select Geometry>General Tools>Import/Export>Export Geometry

3. Using Settings below, data click to accept.  Save file as PI#Alignments.xml.
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Table 12.2: Alignment Feature Definitions to Export to LandXML

MAIN_P_CONSTCL 100 MAIN_P_CONSTCL 500 MAIN_P_SIDECL 100 MAIN_P_SIDECL 500
PROP_E_PAR PROP_E_POEL PROP_E_RWE PROP_E_LTD-ACCESS
PROP_E_RWE-LTD-
ACCESS

PROP_E_RWU
REQD_P_DWESMT REQD_P_PESMT REQD_P_REQD REQD_P_TESMT

12.2.2 Generate GDOT Deed File(s)

In order to write out data from ORD to use as the Metes and Bounds description for generation of Deeds, the 
GDOT Deed_ORD.xsl Style Sheet is used. The GDOT Deed_ORD.xsl Style Sheet is utilized to create an output 
(.OUT) file which is imported into the stand-alone GDOT Deed Writer program.

The Deed Writer Program is used by the Office of Right of way to create Deeds for the purchase of Right of Way 
on the project.

NOTES:

a) For Detailed Instructions on using the GDOT Deed_ORD.xsl Style Sheet, please see the 
GDOT Style Sheet Help Files included with the GDOT_Org_Civil_Standards_CaddAll.exe 
download for external use.  Internally, these are located in ProjectWise, here: Style 
Sheets.

b) Points must be stored at the PC and the PT of Curves in order to generate an 
accurate Metes and Bounds Deed file.

c) The Points must be stored in a clockwise direction to facilitate the Deed Writing process.
d) To access the Style Sheet, select the following command in the ORD menu:

OpenRoads Modeling ►Home ► Reports ► Legal Report

e) The GDOT Deed_ORD.xsl Style Sheet Report should be saved with an .OUT Extension.

f) The Naming Convention for the GDOT Deed_ORD .OUT File will be Alignment Name.out

(Example: DE31.out).

Table 12.1
File Naming Convention – GDOT Deed

Location: OpenRoads Modeling ►Home ► Reports ► Legal Report

File Name Example
Alignment Name.out DE31.out

pw://gdot-go-pwis01.gdot.ad.local:ProjectWise/Documents/P%7bf20aff87-2741-4b73-ab11-aa4f290cdc8f%7d/
pw://gdot-go-pwis01.gdot.ad.local:ProjectWise/Documents/P%7bf20aff87-2741-4b73-ab11-aa4f290cdc8f%7d/
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12.2.3 ORD Project Data Sheet(s)

The Project Data Sheet is used to document the design files and data contained in the ORD Database File(s). This 
documentation not only assists the Designer during the Design process but also is used by other personnel who 
may inherit the project in latter stages to help identify the correct design files and design objects. This Project 
Datasheet File should be submitted as an Additional Deliverable along with the associated ORD Project Database 
File(s).

NOTES:

1. The Project Data Sheet is available on the ROADS webpage here, under the Design 
Guidelines section.

2. The Designer should store this file, along with any other project documentation and 
ORD Project Database File(s), in appropriate folders in ProjectWise (internally) or Project 
Folders (externally).

http://www.dot.ga.gov/PS/DesignSoftware/OpenRoads
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12.2.4 GDOT ORD Design Data Quality Assurance Checklist

The GDOT ORD Design Data Quality Assurance Checklist shall be documented and submitted by the Designer or 
Design Consultant. This document is an overall checklist to ensure that the applicable Design Deliverables are 
submitted to Construction and/or GDOT Design Personnel after the Design aspect of the Project is completed. 
Some of the areas listed in the checklist include: Design Data submitted, Proposed Terrain Surface information, 
Geometry Data, Templates, Corridors, Cross-Sections, etc. The Designer is to use this checklist to verify that the 
Project Deliverables contain all the requisite data before submittal for the Field Plan Reviews, Letting and 
Construction Phases.

NOTES:

a) The GDOT ORD Design Data Quality Assurance Checklist may be downloaded from 
the ROADS webpage here: 

b) The Designer should store this file, along with any other project documentation and 
ORD Project Database File(s), in appropriate folders in ProjectWise (internally) or Project 
Folders (externally)

12.2.5 GDOT ORD Assembly of ModelReview.dgn

The GDOT ORD ModelReview.dgn will be generated by the Designer or Design Consultant to be included with all 
Field Plan Review requests for non-legacy software projects submitted after January 1st 2026. This 3D model 
review file submission requirement for Field Plan Reviews will serve as QC-QA supporting the development of 
the 3D model through all design phases instead of only a final submission.

NOTES:

a) The ORD Design Workflow Processes document has been updated to include a new workflow for 
assembling a composite 3D model review file (ModelReview.dgn). See ORD Design Workflow 
Processes Chapter 5 – Assembly of ModelReview.dgn available on the ROADS page here.

b) The Designer should store this file in appropriate folders in ProjectWise following the file name 
convention outlined in the ORD Design Workflow Processes document.

http://www.dot.ga.gov/PartnerSmart/DesignSoftware/OpenRoads/Design_Data_ORD_QA.pdf
https://www.dot.ga.gov/PartnerSmart/DesignSoftware/OpenRoads/ORD%20Design%20Workflow%20Processes.pdf
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12.3 ORD File Deliverables to Contractors

Note: The ORD Workflows for 3D Construction Deliverables available at this link supersedes the current 
requirements outlined in this section for non-legacy software projects submitted in January 2026.

When a project is complete and let to construction, there are several additional File Deliverables which are 
required to be submitted by the Designer for use by Contractors. The following Section contains information on 
how to generate the following deliverables:

• Alignment File Description(s)
• Alignment Report File(s)
• 3D Model File(s)

NOTE: The Alignment File Descriptions and Alignment Report Files will be provided Pre-Award of the contract.

12.3.1 Alignment File Descriptions

Text file descriptions of the Baseline Alignments (Feature Definitions of MAIN_P_CONSTCL 100, 
MAIN_P_CONSTCL 500, MAIN_P_SIDECL 100 and MAIN_P_SIDECL 500) will be provided to the Contractor. 
These text files will list all of the applicable Baseline Alignment information including the associated Curve Data. 
A Graphical Filter Group may be used to select the above-listed Feature Definitions so that the Descriptions can 
be generated for each Alignment at the same time and included in one .TXT output file.

NOTES:

a) For Detailed Instructions on using the GDOT Alignment File Descriptions_ORD.xsl Style 
Sheet, please see the GDOT Style Sheet Help Files found in the 
GDOT_Org_Civil_Standards_CaddAll.exe download for external use.  Internally, these 
can be found in ProjectWise here: Style Sheets.

b) To access the Style Sheet, select OpenRoads Modeling Geometry  General ToolsReports 
 Horizontal Geometry Report

c) Following the command prompts, select all alignments that are required for inclusion in 
the Alignment Report

d) The GDOT Alignment File Descriptions.xsl Style Sheet Report should be saved with a .TXT 
Extension.

e) The Naming Convention for the GDOT Alignment File Descriptions will be PI#_AL.txt

(Example: 1234567_AL.txt).

f) The following Feature Definitions will be written to the Alignment File Descriptions Report:
• MAIN_P_CONSTCL 100
• MAIN_P_CONSTCL 500
• MAIN_P_SIDECL 100
• MAIN_P_SIDECL 500

https://www.dot.ga.gov/PartnerSmart/DesignSoftware/OpenRoads/ORD%20Workflows%20for%203D%20Construction%20Deliverables.pdf
pw://gdot-go-pwis01.gdot.ad.local:ProjectWise/Documents/P%7b536f565a-81da-4b79-afa8-9dab929e503b%7d/
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12.3.2 Alignment Report Files

Alignment Report Files will be utilized to supply alignment information to the Contractor for use in GPS 
equipment. This report depicts the alignment information located at 50 Foot Station intervals at a Zero offset. 
The report is required for each of the alignments with Feature Definitions of MAIN_P_CONSTCL 100, 
MAIN_P_CONSTCL 500, MAIN_P_SIDECL 100 and MAIN_P_SIDECL 500.

NOTES:

a) For Detailed Instructions on using the GDOT Alignment Report_ORD.xsl Style Sheet, 
please see the GDOT Style Sheet Help Files found in the 
GDOT_Org_Civil_Standards_CaddAll.exe download for external use.  Internally, these 
can be found in ProjectWise here: Style Sheets.

b) To access the Style Sheet, select OpenRoads Modeling Geometry  General ToolsReports  
Horizontal Geometry Report

c) The GDOT Alignment Report.xsl Style Sheet should be saved with an .HTML Extension.

d) The Naming Convention for the GDOT Alignment Report will be PI#_Alignment 
Report.html (Example: 1234567_Alignment Report.html).

e) The following Feature Definitions will be written to the Alignment File Descriptions Report:

• MAIN_P_CONSTCL 100
• MAIN_P_CONSTCL 500
• MAIN_P_SIDECL 100
• MAIN_P_SIDECL 500

12.3.3 3D Model Files

3D Model files are now required Letting deliverables for any projects that propose earthwork/grading 
operations. These files will be provided “for information only” and will not be considered contract documents. 
There are no changes to the required earthwork files to be submitted at final plans; earthwork quantities and 
files should be submitted using the average end area method/reports. Instructions for creating Land XML files are 
currently under development, for eventual inclusion in the ORD Workflow Processes document available on 
GDOT’s website at this link:

http://www.dot.ga.gov/PartnerSmart/DesignSoftware/OpenRoads/ORD%20Design%20Workflow%20Processes.
pdf

The two files, in Land XML format, that shall be delivered are:

• PI#_EXIST.XML (containing the complete existing ground surface)
• PI#_FINISH.XML (containing a single merged final finished grade of the proposed surface)

For more details on these 3D Model deliverables, please see the 3D Modeling Guide on ROADS:

https://www.dot.ga.gov/PartnerSmart/DesignManuals/OtherResources/3D%20Modeling%20Guide.pdf

http://www.dot.ga.gov/PartnerSmart/DesignManuals/OtherResources/3D%20Model%20Best%20Pra 
ctices%20FAQ.pdf

pw://gdot-go-pwis01.gdot.ad.local:ProjectWise/Documents/P%7b536f565a-81da-4b79-afa8-9dab929e503b%7d/
http://www.dot.ga.gov/PartnerSmart/DesignSoftware/OpenRoads/ORD%20Design%20Workflow%20Processes.pdf
http://www.dot.ga.gov/PartnerSmart/DesignSoftware/OpenRoads/ORD%20Design%20Workflow%20Processes.pdf
https://www.dot.ga.gov/PartnerSmart/DesignManuals/OtherResources/3D%20Modeling%20Guide.pdf
http://www.dot.ga.gov/PartnerSmart/DesignManuals/OtherResources/3D%20Model%20Best%20Pra
http://www.dot.ga.gov/PartnerSmart/DesignManuals/OtherResources/3D%20Model%20Best%20Practices%20FAQ.pdf
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